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Navigating in Adobe® Reader®

Adobe® Reader® enables you to view and print files saved in Adobe 
Portable Document Format (PDF). PDF is a universal format that can be 
viewed, navigated, and printed. You can locate information quickly by 
performing full-text searches of PDF documents, or move through 
documents one page at a time.

To get full information about Reader options, Pearson Digital Learning 
recommends that you become familiar with and use the Reader Guide 
located in the Help pull-down menu. It is easy to understand and very 
useful.

This guide introduces these Reader tool bar features:

! “Navigation” on page 1
! “Full-text Search” on page 3
! “Printing PDF Documents” on page 5
! “Tips” on page 6

If this is your first time 
using Reader, click the 
Next Page button on 
the tool bar located at 
the top of the screen, 
or press Page Down 
on your keyboard. 

Navigation

Tool Bar Buttons

The tool bar and scroll bars provide several ways to move through a 
document. Tool bar buttons, located at the top of the screen, enable you to 
move between or within documents.
Copyright © 2000–2004 Pearson Digital Learning Navigation  1
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Use these six tool bar buttons for navigation.

Hypertext

PDF documents also can contain hypertext—text that jumps you to 
another page or document when clicked. Blue text often indicates a 
hypertext link, but hypertext can be any color.

To check for hypertext, move the open hand cursor over the text. If the 
open hand changes to a pointing hand, the text is linked. To view a linked 
document, click once on hypertext. The program moves to the related 
topic for you to read.

Bookmarks

Bookmarks are a special feature of Reader. The Bookmark palette 
displays to the left of the screen. It contains a list of a document’s major 
sections. Click text in the Bookmark palette to jump to another location. 
Use the Show/Hide Navigation Pane button on the tool bar to hide or 
display the Bookmark palette.

Navigation Button Icon Description

First Page Jumps to the first page in the current 
document.

Previous Page Moves to the last page you viewed in the 
current document.

Next Page Moves to the next page in the current 
document.

Last Page Jumps to the last page in the current 
document.

Go to Previous 
View

Jumps back to a page or document you 
already viewed.

Go to Next View Jumps forward to a page or document you 
already viewed.
2  Navigation Copyright © 2000–2004 Pearson Digital Learning
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Full-text Search

Tool Bar Buttons

Five tool bar buttons enable you to find text in the current document 
or search for text across many documents. The first button, 
displaying only the binoculars icon, enables you to Find text only in 
the current document.

Use the four remaining buttons to perform a full-text Search across 
documents.

Searching Across Documents

The first time you perform a search, you must add the index you want to 
search. Then, enter the search words and select documents to review 
from the search results list.

Adding Indexes

1. Click Search on the tool bar. The Adobe Reader Search window 
displays.

2. Click Indexes. The Index Selection window displays available indexes. 
If the window is blank, or does not display the index you want, click 
Add.

Search 
Buttons Icon Description

Search Displays the Adobe Reader Search window 
where you type your search text and select the 
index to search.

Search Results Displays the Search Results window enabling 
you to view another document that matches 
your search criteria.

Previous 
Highlight

Moves back to a previous page in the current 
document containing highlighted text.

Previous 
Highlight

Moves back to a previous page in the current 
document containing highlighted text.
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3. In the Add Index window, select index.pdx – typically located in the 
same directory as the documents you are viewing. Click Open.

The name of the index is now selected as an available index in the 
Index Selection window.

4. Click OK.

Searching Selected Indexes

1. Click Search on the tool bar. The Adobe Reader Search window 
displays.

2. Type your search words. Click Search. The Search Results window 
displays a list of documents containing items that match your search.

3. Double-click the name of the document you want to view. The words 
that match your search are highlighted in the document.

If the Search button is dimmed or your search results do not relate to 
the topic you want, confirm the correct index has been added.
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4. Click the Previous Highlight or Next Highlight button on the tool bar to 
move through the document.

Printing PDF Documents
Reader enables you to specify a range of pages to print in the Print dialog 
box. Refer to the Current Page field on the status bar to determine the 
current page number and total number of pages in the document.

1. Navigate to the page or document you want to print.

2. Click the Print button on the tool bar at the top of the screen, or choose 
File | Print. The Print dialog box displays.

3. Specify the printer, page range, number of copies, and other options. 
Click OK.

If you do not find the information you need, click the Search Results 
button on the tool bar to display the Search Results window. Select a 
new document to view.
Copyright © 2000–2004 Pearson Digital Learning Printing PDF Documents  5
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Tips

Rollover Feature

Use the rollover feature to learn the names of the tool bar buttons. Place 
the cursor over a tool bar button and pause briefly. The button name 
displays.

Help

To get full information about Reader options, Pearson Digital Learning 
recommends that you become familiar with and use the Reader Guide 
located in the Help pull-down menu.

Status Bar

This bar is located at the bottom of the window. Look at the status bar 
when you want information on the current document, for example, the 
current page number and total number of pages in the document.

Function Description

F7 Displays the Menu bar.

F8 Displays the tool bar.

Help The Reader Guide is available under Help on 
the Menu bar. Press F7 to display the Menu 
bar.
6  Tips Copyright © 2000–2004 Pearson Digital Learning
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Hand Tools

These three hand cursors help you navigate within and between 
documents.

Cursor Description

Open Hand The open hand is the default cursor.

Pointing Hand The pointing hand displays when you move 
the cursor over linked text. Click the text to 
jump to another page or document.

Grabbing Hand The grabbing hand moves the page on the 
screen. Place the open hand on the page, 
hold down the left mouse button, and move 
the mouse up or down to move the page. Use 
this feature in addition to the scroll bar to 
move up and down in a document.
Copyright © 2000–2004 Pearson Digital Learning Tips  7
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Using SASIxp™ Educational Software

This section provides information about the basics of using SASIxpTM 
educational software. No matter which atoms you use, the basic program 
functions behave the same way. This section provides an overview to 
guide you as you work with the SASIxp software.

Starting and Logging In
1. Double-click the SASIxp icon. The Welcome window displays.

2. In the User ID field, type your SASIxp user ID.

3. Tab to the Password field and type your password. (For security 
reasons, asterisks display instead of your password.)

4. Click Login. You also can press the Return key (Macintosh®) or the 
Enter key (Windows®).

If the system displays a message, you typed an invalid user ID or 
password. Click OK to clear the message. Retype your user ID and 
password in the Welcome window fields. Click Login.
Copyright © 2000–2004 Pearson Digital Learning Starting and Logging In  9
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After three failed login attempts, the system displays a message 
indicating that the program will quit. Click OK to clear the message and 
return to the Macintosh Desktop or to Windows.

Exiting the SASIxp Software

From the File menu, select Quit to exit from the SASIxp software.

If the Welcome window is idle for five minutes before you log in, the 
SASIxp educational software closes automatically.
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Setting Up and Changing Passwords
A SASIxp Security Officer assigns your initial system password. You can 
change your password at any time from the Welcome window or from the 
lockout screen used to hide the SASIxp desktop.

Changing Your Password

1. Double-click the SASIxp icon. The Welcome window displays.

2. In the User ID field, type your SASI user ID.

3. In the Password field, type your SASI password. For security reasons, 
asterisks display instead of your password.

4. Click Change Password. The User Password window displays.

5. In the Enter your new password field, type a new password.

6. In the Enter your new password again field, retype your new password.

7. Click Change to record your password and return to the Welcome 
window.

8. Click Login to log in using your new password. You also can click Exit 
to save your password and quit the program.
Copyright © 2000–2004 Pearson Digital Learning Setting Up and Changing Passwords  11
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Touring the Desktop
The SASIxp desktop is your working environment. The desktop consists of 
four main components:
! Menu Bar
! Toolbar
! Workspace
! Message Center

Toolbar
Vertical bar with docking
bays for atom aliases.

Menu Bar
Horizontal bar displaying File, Edit, Windows,
Data and Help menus, plus any Application menu
associated with the current atom.

Workspace
The largest part of the Desktop, and the area 
where you work with applications and data.

Message Center
Horizontal bar with message bays for
information about fields and functions.
12  Touring the Desktop Copyright © 2000–2004 Pearson Digital Learning
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Workspace Items
! SASIxp Modules Globe
! Folders
! Atoms
! In Folder
! System Folder
! Eraser

Folders
Storage areas for atoms 
and other folders.

Atoms
Basic components of the SASIxp
software, atoms run applications
and display data.

SASI Modules Globe
Contains the folders and 
application atoms set up by 
the System Administrator.

In Folder
Receives atoms from other 
users over the network.

System Filter Folder
Contains active filter atoms.

Eraser
Removes folders, atoms, and 
atom aliases from the Desktop.
Copyright © 2000–2004 Pearson Digital Learning Workspace Items  13
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Toolbar
The Toolbar displays on the left side of the desktop. It provides a place to 
store aliases for atoms that you use frequently so that the atoms are easy 
to find and readily accessible. An alias represents an atom that is stored 
elsewhere on the desktop. You can click an alias in the toolbar to open the 
atom and use it.

! Create multiple toolbars with different atoms for different tasks.

! Create multiple aliases for one atom and store in different toolbars.

! Create an alias for any SASIxp atom (system-supplied or user-created).
14  Toolbar Copyright © 2000–2004 Pearson Digital Learning
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Creating a Toolbar

1. From the Toolbar Selection Box, select the New Toolbar option. The 
system displays a window for naming the new toolbar.

2. In the Enter New Toolbar Name field, type a name for the new toolbar.

3. Click OK to create and save the new toolbar. The new toolbar displays 
with empty areas.

4. Open the folder that contains the atom that you want to add to the 
toolbar.

5. Click the atom, then drag and drop it into any empty bay on the toolbar. 
This step creates an atom alias in the toolbar while the original atom 
remains in the same location. The system displays the same icon for 
the atom alias that is used by the original atom.

6. Repeat steps 4 and 5 until you have aliases for all the atoms that you 
want. The toolbar is saved automatically.

Displaying a Toolbar

From the Toolbar Selection Box, select a toolbar. You also can use the 
Forward/Back arrows to cycle through a list of available toolbars.

Opening Atoms with an Alias

1. Display the toolbar that contains the atom alias that you want.

2. Click the atom alias on the toolbar to open the atom. You can work with 
pages and data in the atom as you normally would.

Renaming Toolbars

1. Display the toolbar that you want.

2. From the Toolbar Selection Box, select the Rename Toolbar option. 
The system displays a window for renaming the toolbar.

3. Type a new name for the new toolbar.

4. Click OK to save the new toolbar name.
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Removing Aliases from a Toolbar

1. Display the toolbar that you want.

2. Hold down the Option key (Macintosh) or the Alt key (Windows) and 
click the alias that you want to remove, then drag and drop it over the 
Eraser icon in the lower right corner of the workspace. The Eraser 
moves back and forth as chalk dust displays, and the system places 
the removed atom alias in the Eraser folder.

3. From the File menu, select the Empty Eraser option to remove the 
atom alias and all other erased contents from the system permanently.

Emptying Toolbars

1. Display the toolbar that you want to empty.

2. From the Toolbar Selection Box, select the Empty Toolbar option. The 
system removes all aliases from the toolbar but retains the name of the 
toolbar. You can add new aliases to the toolbar at this point.

Deleting Toolbars

1. Display the toolbar that you want to delete.

2. From the Toolbar Selection Box, select the Delete Toolbar option. The 
system removes the toolbar contents and name so that they are no 
longer accessible.

Toolbar Exercise

1. Create a new toolbar named ‘Student.’

2. Open the SASI Modules Globe.

3. Open the Student Info folder.

4. Create atom aliases in the new toolbar for these atoms:

! Enrollment atom
! Student atom
! Parent Guardian atom

5. Open the Health/Emergency folder.

6. Create atom aliases in the new toolbar for these atoms:

! Emergency atom
! Health atom
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7. Remove the Enrollment atom alias from the toolbar.

8. Display another toolbar.

9. Display the toolbar named ‘Student.’

10. Open the Student atom from the toolbar.

11. Close the Student atom using the close box in the title bar.

12. Empty the toolbar named ‘Student.’

13. Delete the toolbar named ‘Student.’

14. Close all remaining open folder windows at once.

Message Center
The Message Center is located at the base of the SASIxp desktop. It 
contains four information bays, two on either side of the XP icon. A Mini 
Pic box that displays photos is located next to the XP icon.

Screen Area Description

Top Left Information 
Menu

Displays a description of any desktop 
component or field where the mouse pointer 
is currently pointing. As you move the mouse 
pointer around the desktop, the displayed 
information changes.

Lower Left Information 
Menu

Displays the customer identification assigned 
to you. When you use functions that take 
time, such as queries or reports, the lower left 
bay displays a progress bar that indicates 
how much of the function is complete. The 
progress bar or an error message temporarily 
covers the customer identification 
information. This bay also displays any error 
messages generated when you enter data or 
perform a function.
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Right Information Menu Provides a Personal Data Center designed to 
display supplemental data as you work in 
atom screens that do not contain fields for 
that data. You can select up to four data fields 
to be used (two in each bay). For example, 
as you are working in the Health atom, you 
might display birth date and teacher from the 
Student atom. As you’re working in the 
Attendance atom, you might display Enter 
Date from the Enrollment atom.

Status Bar Spans the top of the Message Center and 
displays:

! Name of the school
! Number of the school 
! School year currently selected
! The current ABACUSxpTM data set
! User ID used for log in
! Current date

The bar indicates if the user is a Security 
Officer.

Double-click the status bar to display the 
Change School/Year window.

Mini Pic Displays an individual’s photo (if available) 
when the record for a student, teacher, or 
staff member is active. Double-click the photo 
to display a larger photo for use with screens 
that don’t display photos.

XP Icon Displays the version of the software in the top 
left information bay when you position the 
cursor on the logo.

Screen Area Description
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Icons in the Status Bar

Personal Data Center
The two bays on the right side of the Message Center provide you with a 
Personal Data Center. The Personal Data Center enables you to display 
supplemental data (from the Student file only) as you work in atom forms 
that do not contain fields for that data. Each data bay hold two fields so 
you can display up to four fields in the Personal Data Center.

Table 1: 

Finder Icon (Macintosh only). Click this 
icon to temporarily drop to the Macintosh 
Finder to work with other programs 
without exiting the SASIxp educational 
software (open screens remain open and 
on display). To return to the SASIxp 
educational software, click again on the 
Finder icon.

Data Lock Icon. Click this icon to put all 
data fields in view-only mode so that data 
cannot be entered or accidentally 
changed. To unlock data, click this icon 
again, enter your password in the dialog 
box provided, and click OK.

Screen Lock Icon. Click this icon to hide 
the SASIxp desktop behind a lockout 
screen so that data cannot be viewed. To 
unlock the screen, enter your password 
in the field provided and click OK. To quit 
the application, click Exit.

Filter Atom Icon. This icon displays only 
if a Filter atom is contained in the System 
Filter folder and thus active. It serves as 
a reminder that a filter is active. You can 
click this icon as a shortcut to opening 
the System Filter folder.
Copyright © 2000–2004 Pearson Digital Learning Personal Data Center  19



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
SASIxp Software Considerations

! As you display different records within an atom, data in the information 
bays displays for the currently selected record.

! As you open different atoms, the fields used in the information bays 
remain the same. You can select new fields at any time.

! Data does not display in information bay fields if there is no link 
between these fields and the current form. For example, Parent/
Guardian data does not display if you are working in the Teacher form.

Selecting Fields for Information Menus

1. Open the Student atom.

2. Click and hold any available data field even if it is blank. A dotted line 
displays around the selected field.

3. Drag the dotted outline over one of the Personal Data Center fields 
and drop it there. The system activates the selected field within the 
Personal Data Center.

Replacing Fields in Information Menus

1. Open the Student atom.

2. Click and hold any available data field in the form even if it is blank. A 
dotted line displays around the selected field.

3. Drag the dotted outline over a Personal Data Center field that already 
contains an active form field and drop it there. The system activates 
the newly selected data form field in the Personal Data Center.

Removing Fields from Information Menus

Hold down the Option key (Macintosh), the Alt key (Windows), or the right 
mouse button (Windows) then click each field you want to remove. The 
system removes the field from the Personal Data Center.
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Drag-and-Drop Capabilities
The drag-and-drop capability gives you added speed and flexibility in 
working with folders, atoms, screens, and fields. You can move objects 
around the desktop and access data with a click of the mouse button. 
Examples of what you can do include:

! Drag and drop folders and atoms to reposition them on the desktop.
! Drag and drop a student record field from one screen onto another 

screen.
! Drag and drop a student record field from one screen onto any 

student-related atom to open that atom and display the student’s 
record.

! Drag and drop fields from a record or list to create a data atom for that 
record or list. You can then double-click that atom to instantly access 
the record or list.

! Drag and drop an atom into a toolbar bay to create an alias for that 
atom. Click the alias to open the atom.

Using the Drag-and-Drop Technique

1. Click any object on the desktop (field, student photo, atom, folder) until 
an outline displays around it, then hold down the mouse button while 
dragging the mouse across the desktop.

2. Release the mouse button to drop the object onto the desktop, into an 
open or closed folder, or onto an atom icon or an open atom screen. 
When an object is over an atom, brackets display. When an object is 
over a closed folder, directional arrows display.
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Folders
Folders store atoms. They are represented on the desktop by briefcase 
icons. You can arrange folders any way you want on the desktop. You can 
also create your own folders to store and organize user-generated atoms 
or atom aliases.

Opening a Folder

Double-click a briefcase icon to open a folder. You can open as many 
folders as you want simultaneously. These folders remain open in the 
background as you work with other SASIxp items and functions.

Activating an Open Folder

Click anywhere in the folder screen. Black lines display around the folder’s 
title bar to indicate the folder is active, and the folder displays in the 
foreground of the desktop.

OR

Display the Windows menu from the desktop menu bar. This menu 
includes all open folders and atoms. Select a folder from the menu.

Repositioning an Open Folder in the Workspace

1. Click and hold the mouse button anywhere on the folder’s title bar. An 
outline displays around the folder window indicating that the folder is 
mobile.

2. Drag and drop the folder to a new position in the workspace.

Viewing Items in Folders by Name or Icon

From the File menu on the desktop menu bar, select the View by Name 
option to display folders by their names.

OR

From the File menu on the desktop menu bar, select the View by Icon 
option to display folders with their icons.
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Viewing Atoms Beyond a Window Edge

Use the horizontal and vertical scroll bars that display on an open folder 
window when the open folder contains atoms (or other folders) that are not 
immediately visible.

Copying Atoms from a Folder

1. Double-click any folder.

2. Hold down the Option key (Macintosh) or the Alt key (Windows), then 
drag and drop any atom within that folder into the Workspace.

Resizing Folders

1. Click Resize in the lower right corner of an open folder. An outline 
displays around the folder indicating it is mobile.

2. Use the mouse to drag the lower right corner of the outline to the left or 
right, or upward or downward, depending on what size and shape you 
want the window to be.

3. Release the mouse button when the window is the size that you want.

Closing Folders

Click anywhere in an open folder to make it the active folder and bring it to 
the foreground of the desktop. You can then:

! Use the Close button in the left corner of the title bar (Macintosh).

! Double-click the Control-menu box in the left corner of the title bar 
(Windows).

Closing All Open Folders

Depending on your system, you can close all folders at once.

! Hold down the Option key and click the Close button of the active folder 
at the foreground of the desktop (Macintosh).

! Hold down the Alt key and double-click the Control-menu box in the left 
corner of the title bar (Windows).
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Creating Folders
Create an unlimited number of folders in the SASIxp system. You can use 
folders for many purposes, such as storing different types of atoms (data, 
report, query, or filter atoms). Also, you can move folders that you create 
within the workspace and you can copy atoms into them.

Creating New Folders

1. From the File menu, select the New Folder option. The system 
displays the screen for creating folders.

2. In the top field of the screen, select a folder storage area from the list.

3. In the Save as field, enter a name for the new folder.

4. Click Save to create and save the new folder (or click Cancel to 
discard the folder). A briefcase icon for your new folder displays in the 
selected storage area.

5. Click the new folder. From the File menu, select Info. From this option, 
you can enter a folder description, assign a Hot Key, or lock the folder.

Adding or Copying Atoms to Open Folders

Click the atom that you want to add to the open folder, then drag-and-drop 
it into the folder.

If you want to add a copy of an atom to the open folder, hold down the 
Option key (Macintosh) or the Alt key (Windows), then click the atom, and 
drag and drop it into the open folder. The original atom remains unaffected 
while a copy is stored in your folder.

Adding Atoms into Closed Folders

1. Click the atom that you want to add to the closed folder, then drag it 
over the folder icon until the folder icon is highlighted.

2. Drop the atom onto the folder when four arrows point to the folder’s 
center to indicate that the item is positioned correctly over the folder.
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Erasing Folders

1. Click and hold the folder that you want to delete.

2. Drag and drop the folder over the Eraser icon in the lower right corner 
of the workspace. The Eraser moves back and forth as chalk dust 
displays, and the system places the selected folder in the Eraser 
folder.

! To restore an erased folder, double-click the Eraser folder. From the 
Eraser folder, select the folder to restore, then drag and drop it back 
into the workspace. (Any items that you leave in the Eraser folder 
remain there until you permanently delete them.)

! To delete the erased folder permanently, select Clean Eraser from the 
File menu. The system permanently deletes all items in the Eraser 
folder.

Folder Exercise

1. Create a new folder and name it ‘Enrollment.’

2. Open the SASI Modules Globe.

3. Open the Student Info folder, then copy the Enrollment atom and the 
Student atom into the Enrollment folder.

4. Open the Enrollment folder.

5. Copy the Parent Guardian atom from the Student Info folder into the 
Enrollment folder.

6. Reposition the Enrollment folder window to the center of the 
workspace.

7. Resize the Enrollment folder window to accommodate the three atoms.

8. Close both open folders at once.

9. Erase the Enrollment folder.

10. Clean the Eraser on the desktop.
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Menu Bar
The menu bar displays File, Edit, Windows, and Data menus with options 
for use in within the system. It also displays menus for each active 
application atom.

You can use most options on the File and Windows menus with all folders 
and atoms. You can also use options on the Edit and Data menus with all 
atoms. Use of options on menus that display when an atom is active is 
limited to the active atom.

Working with Menus

When you click any SASIxp menu, one or more menu options display 
below the menu. Active menu options display in black. Inactive options are 
dimmed, indicating these options are unavailable.

You must open an atom to display the menu and menu options that apply 
specifically to that atom.

Selecting Options from SASIxp Menus

! Macintosh: Click the menu name in the menu bar and continue to hold 
the mouse button to display the menu option. Use the mouse to 
highlight the option that you want, then release the mouse to select the 
option.

! Windows: Click the menu name in the menu bar. The menu options 
display until you click an option on the menu.

Use SASIxp Hot Keys to select some menu options. Hot keys display to 
right of the menu option name on the menu. Hot keys are letters preceded 
by the command symbol " (Macintosh) or by Ctrl + (Windows). Hold down 
the Command key or Control key while pressing the letter assignment to 
select the menu option.

Click a folder or atom (to highlight it) so that you can use menu options 
that apply to folders and atoms. When you select a menu option for a 
folder or atom, the option applies only to those folders or atoms that you 
highlighted.
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File Menu Options
T

Option Description

New Folder
Ctrl+N or """"N

Enables you to create folders. Contains a 
Save As field for naming new folders and 
enables you to specify where a folder should 
be stored.

Open
Ctrl+O or """"O

Opens a selected folder or atom. Click a 
closed folder or atom icon to select it. You 
also can open folders and atoms by double-
clicking them.

Close
Ctrl+W or """"W

Closes a selected folder or atom. Click a 
closed folder or atom icon to select it.

View by Name
OR
View By Icon

Enables you to view atoms in an open folder 
by name in alphabetical order. If the atoms in 
a folder are already displayed by name, this 
option is called View by Icon.

Atom / Form Info
Ctrl+I or """"I

Displays a window with information about the 
selected folder or atom. If an atom is open, 
this option is entitled Form Info.

Duplicate
Ctrl+D or """"D

Copies an atom so that it can be stored in 
more than one location on the desktop. To 
copy an atom, first click it to select it. From 
the File menu, select Duplicate Atom. You 
can also hold down the Option key – 
Macintosh, or the Alt key – Windows, click 
the atom, then drag the outline that displays 
to the workspace. Data changes performed 
after opening any copy of the atom get 
reflected in all atom copies.

Install Atom Installs an atom from the network on your 
SASIxp desktop.

Save Desktop
Ctrl+S or """"S

Saves the desktop in its current arrangement. 
If any atoms are open, this option is called 
Save Data. You can also use this option to 
save data on the currently selected form.
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Edit Menu Functions

Find Atom Locates a folder or atom. Use the lists to 
select entries for the first two fields (defaults 
are name and starts with, respectively) and 
type data in the third field. Your search 
criteria to locate the Emergency atom might 
read name starts with emergency. Click Find. 
The system highlights the atom that matches 
your criteria. The system might open a folder 
to locate the atom. You can search on partial 
words in the third field – stu for student.

Find Atom Again Finds the next atom or folder that matches 
your Find Atom search criteria. You might get 
a copy of the atom or a different atom that 
begins with the same letters.

Page Setup Displays window with setup options for 
printing atoms and reports. Settings include 
paper size and page orientation.

Print
Ctrl+P or """"P

Prints an open screen on the desktop. If 
multiple items are open, the active item (in 
the foreground) prints.

Clean Eraser on 
Desktop

Permanently deletes all contents – atoms 
and folders – in the Eraser.

Quit
Ctrl+Q or """"Q

Enables you to exit from the SASIxp 
educational software and return to the 
Macintosh desktop or to Windows. The 
system saves the current desktop 
arrangement and closes any open atoms.

Option Description

Function Description

Undo
Ctrl+Z or """"Z

Undoes the entry you just typed. With the 
cursor still positioned in the same field, select 
Undo. The text is removed and the previous 
entry is restored.
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Windows Menu Functions

Cut
Ctrl+X or """"X

Copies and removes the data from a field. 
Highlight the field contents, then select Cut. 
You can use the Paste function immediately 
to put the cut contents into a different field on 
any form.

Copy
Ctrl+C or """"C

Copies data in a field. Highlight the field 
contents, then select Copy. You can use the 
Paste function immediately to put the copied 
contents into a different field on any form.

Paste
Ctrl+V or """"V

Puts cut and copied data into a field. Click the 
field in which you want to put the cut or 
copied data, then select Paste.

Clear Removes data from a field. Highlight the field 
contents then select Clear.

Select All Selects all closed folders and all atoms in 
open folders. You can move them all, erase 
them all, or select the same option for them 
all, such as Open or Atom Info. Click once 
anywhere on the desktop to deselect all 
items.

Function Description

Function Description

Arrange Windows Arranges all open forms in an overlapped 
cascading pattern so that the Title Bar of 
each one is visible. Most forms cascade from 
the upper left corner of the workspace. The 
forms display in the order in which you 
opened them with the most recently opened 
form visible at the front.

Names of Open
Folders and Atoms

Displays the names of all open folders and 
atoms. This function makes it easy to find 
forms hidden behind other forms. Select an 
item from this list to display it on top.
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Data Menu Functions

Function Description

Find
Ctrl+F or """"F

Clears all form fields and enables you to 
search the active form according to criteria 
you specify in any field.

Add
Ctrl+A or """"A

Clears the displayed form and enables you 
add a new record to a file.

Delete Permanently removes a selected record from 
the system file.

Inactivate Inactivates a selected record, but maintains it 
in the file.

Next
Ctrl+] or """"]

Advances to the next available record, like 
the Forward arrow.

Previous
Ctrl+[ or """"[

Returns to the previous record, like the 
Backward arrow.

Sort List Enables you to organize a matrix list 
according to the values in one or more matrix 
columns. Click a column heading, then select 
this option to sort by the selected column.

Reset Columns Width Resets all matrix widths to their original size.

Export List Exports matrix data to a file in a format 
compatible for use with other applications, 
such as spreadsheets or word processing 
applications.

Graph Displays matrix data in various graph 
formats. Select one column or hold down the 
Shift key and click the heading for each 
column you want to include in the graph.
30  Menu Bar Copyright © 2000–2004 Pearson Digital Learning



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Atom Menu Options

Atom menus list the functions and reports available for specific atoms. 
These atom-specific menus display in the menu bar when an atom is 
opened and change as you open different atoms.

Help Menu Options

Atoms
The SASIxp software contains two atom types:

! Program-generated atoms
! User-generated atoms

Show Item Boxes Displays gray outlines around all editable 
fields in the selected screens. This function 
makes it easier to see where each field 
begins and ends. The name of the function 
changes to Hide Item Boxes after item boxes 
display. Item Boxes display for all forms if this 
option is selected in your User record.

Show Control Buttons Displays three buttons at the bottom of all 
data forms. On the left and right are larger 
versions of the Forward/Backward Arrows 
found at the top of forms. In the center is a 
magnifying glass that quickly activates the 
Find mode.

Function Description

Option Description

SASIxp Help Opens the SASIxp help system.

Online Documentation Opens the Adobe® Reader® and the SASIxp 
Online Training Guides. See Navigating in 
Adobe® Reader®.
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Program-Generated Atoms

Program-generated atoms open SASIxp software that display data forms 
for viewing records. Many of these atoms activate their own atom-specific 
application menu on the desktop menu bar. Program-generated atoms 
typically remain grouped in folders by related function. The system 
identifies these atoms as Action atoms in the Message Center.

User-Generated Atoms

Atoms that you create from application or that are program-generated 
atoms use the same icon as the originating atom. However, these atoms 
display a special symbol in the upper left corner to help you identify them 
as user-generated.

Table 2: 

Data atoms enable you to save single or multiple 
records in separate atoms. You can open these 
atoms to quickly access records. The symbol for 
a data atom is an orange data form.

Query atoms enable you to save the results of 
query statements for repeated use. The symbol 
for a Query atom is a yellow question mark.

Filter atoms enable you to save query 
statements as filters for screening data so that 
only certain records are available when you print 
reports or perform a Find. The symbol for a Filter 
atom is a green funnel.

Report atoms are used to save custom reports 
for repeated use. The symbol for a Report atom 
is a pink page emerging from a printer.
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Opening an Application Atom from the Workspace

Double-click the atom. You also can click the atom to highlight it, then go to 
the File menu and select the Open option.

Opening Atoms with an Alias

1. Find the toolbar that contains the atom alias for the atom that you want 
to open.

2. Click the atom alias to launch and use the atom as usual. You can 
open additional atoms without closing any open atoms.

Activating Open Atoms

Click anywhere in the atom form. Black lines display around the atom 
window’s title bar to indicate the atom is active, and the atom displays in 
the foreground of the desktop.

OR

Display the Windows menu from the desktop menu bar. This menu 
includes all open atoms and folders. Select an atom from the menu.

Closing Atoms

Click anywhere in an open form to make it the active form in the 
foreground of the desktop. You can then:

! Click Close on the atom form.
! From the File menu, select the Close option.
! Use the Close button in the left corner of the title bar (Macintosh).
! Double-click the Control-menu box in the left corner of the title bar 

(Windows).

Closing All Open Atoms

Click in any open screen to make it active in the foreground of the desktop. 
Close all open atoms simultaneously using one of these steps:

! Hold down the Option key and click the Close button of the active 
folder at the foreground of the desktop (Macintosh).

! Hold down the Alt key and double-click the Control-menu box in the left 
corner of the title bar (Windows).
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Screen Elements

Atom Screen Elements

Forward/Back 
Arrows

Title Bar

Data Fields

Pop-up Lists/
Down Arrow

Close Button
Forward/Back 

Arrows

Item Box

Photo 
Box

Tabs

Control Buttons Close and Find 
Buttons

Element Description

Close Button Closes an atom screen with one click.
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Control Buttons Optional buttons that display at the bottom of forms. The left and 
right control buttons are larger versions of the forward/ backward 
arrows at the top of data forms. The center button is a magnifying 
glass that activates the Find mode. From the Data menu, select 
Show Control Buttons to display the buttons in an individual form.

Data Fields Display data in atom screens. As you move the mouse pointer over 
data fields, each field’s label displays in the top left bar of the 
Message Center along with the number and type of characters 
(alpha or numeric) the field accepts.

Down Arrow Displays in fields that contain pop-up lists of predefined field values.

Find Button Starts the Find function, which enables you to display one or more 
records that match criteria you define.

Forward and Back 
Arrows

Enable you to advance forward or backward through individual 
records displayed in a screen. Forward and backward arrows are 
located next to the first data field heading.

Item Boxes Optional gray boxes that outline all data fields in a screen to make it 
easier to see where each field begins and ends. From the Data 
menu, select Display Item Boxes to display boxes in individual 
screens.

Link Arrows Small arrows in atom screens that provide links to other atoms. In 
some cases, arrows point to fields where data came from another 
atom. Click a link arrow to launch the second atom. When you close 
the second atom, you return to the original screen.

Page Selection Box and 
Up and Down Arrows

Enable you to access additional pages in atoms. Click the page box 
to display a pop-up list of available pages, then use the mouse to 
select a page. Click the arrows in the box to the left to select pages 
sequentially. Dark arrows indicate whether pages are available 
before or after the one currently displayed.

Tabs An alternative to Page Box and Up and Down Arrows for accessing 
additional pages in atoms. A tab indicates the name of the page that 
displays when you click the tab.

Photo Box Displays a photo in the Student, Teacher, and Staff screens when 
one is available for the current record.

Element Description
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Pop-up Lists Contain program-defined values or school-defined values for an 
atom field. To select a pop-up list item, you can:

! Click the field to display the list and continue to hold the mouse 
button while selecting the item you want.

! Click the field to display the list, then release the mouse. Use 
the mouse to click the item on the list that you want.

! Click the field to display the list, then release the mouse. Use 
the up and down arrow keys to highlight the item in the list that 
you want, then press Enter.

Program-defined Values Hard-coded values delivered with the system that cannot be 
changed. Examples include the values for UnL – Unlisted Phone 
Number, and Ctz – Citizenship in the Student atom. See Defining 
and Using Student Demographics.

Save and Undo Buttons Replace the Find button when you change or enter data in a screen. 
Select Save to save new entries or select Undo to restore 
previously saved data.

School-defined Values Can be customized according to the needs of your school. Values 
that need only a simple description, such as ethnic codes or English 
proficiency codes, are set in the Tables atom. Values requiring more 
data, such as the discipline codes, are defined in unique Definition 
atoms.

Scroll Bars Enable you to view data beyond the edge of the display area.

Title Bar Displays at the top of open atom window with the atom name and 
the name of any record displayed. You can click the title bar to drag 
the screen to a new position in the workspace. You can also close 
an atom from here.

! Click the Close box – Macintosh).
! Double-click the Control-menu box – Windows.
! Click the X – Windows 95.

Element Description
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Displaying Records in a Screen

Display the data screen that you want, then use one of these methods:

! Click the Forward/Backward arrows at the top of the screen to move 
sequentially among records.

! From the Data menu, select the Next or Previous option. You also can 
use the menu option hot keys.

! Use the Find function accessed from the Data menu or by clicking the 
magnifying glass icon at the bottom of the screen.

Finding One Record

1. Display the screen in which you want to locate a record.

2. From the Data menu, select the Find option. You also can click the 
magnifying glass icon in the data form. The system clears all data form 
fields.

3. Enter search criteria in any available fields.

! Specific Values: You can use specific values such as last name or 
student ID to find records. The system displays the first record that 
matches your specified criteria.

! Partial Values: You can enter only part of a value such as the first 
three letters of a last name. The system displays the first record 
that matches your specified criteria. (Use the Forward arrow to 
advance to subsequent records that match the partial value that 
you specified.)

4. Click Find (or press the Return or Enter key) to display records that 
match your criteria.

Data Functions

Data menu functions are used to add, modify, or delete field information on 
atom screens. Most SASIxp atoms use the same procedures for these 
common functions. Links to the Data Functions section display throughout 
this document.

Adding New Records

1. Open the appropriate atom.

2. Find the student’s record.
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3. From the Data menu, select Add atom function. For example, from the 
Data menu in the Classes atom, select Add Classes.

4. Click any field or use the Tab key to advance to a field.

5. Enter data in the field.

! In a blank field, begin typing.
! Highlight existing data, then begin typing to replace it.
! In a field with a pop-up list, click the arrow to display the list. Use 

the mouse to select a value from the list.

6. Click to select a check box to activate an option or click again to clear 
the checkbox.

7. Tab to another field or click in another field, and perform data entry.

8. Click Save to save the data you entered in the form or click Undo to 
restore any data that was saved previously in the record.

9. Click Close.

Modifying Existing Records

1. Open the appropriate atom.

2. Find the student’s record.

3. Select the screen, tab, or page you want to modify.

4. Click on the fields and make changes by entering new data or making 
a new selection from a list.

5. Click Save or Undo to close the record without saving changes.

6. Click Close.

Deleting Records

1. Open the appropriate atom.

2. Find the student’s record

3. Click on the Ln field of the record you want to delete.

4. From the Data menu, select the Delete atom function. For example, 
from the Data menu in the Classes atom, select Delete Classes.

5. Click Save or Undo to close the record without saving changes.

6. Click Close.
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Running Reports

Many menus within atoms of the SASIxp™ educational software contain 
options to create reports. Reports vary among atoms, and the atom from 
which you run a report determines what kind of information can display in 
the report.

Typically, you define parameters like student grade and gender or effective 
dates for the report. The system produces generic reports and enables 
you to create customized reports that you can save and reuse.

You can preview reports, print reports immediately, or send reports to the 
Job Queue. Your workstation must be set up for print previews so that you 
can display reports instead of printing them. If your workstation is attached 
to a printer, directly or through a network, you can print reports any time.

If you do not want to tie up your workstation while a report prints, you can 
send the report to the Job Queue where reports print in the order in which 
they are received or at a time you specify when you send the report.

Generic versus Custom Reports
The system displays the Report Interface when you select any report from 
an application menu. From this screen, you can choose to run generic 
reports—default system reports—or you can customize reports by defining 
report parameters.

! To run a generic report, define certain parameters on a one-time basis 
and leave most of the report unchanged. Parameters enable you to 
specify the range of records to include in a report. Not all reports 
include parameter fields that you can define.

! To create a customized version of a generic report, enter a report 
subtitle, define parameters, and modify the sort order. You can save 
custom reports, which are saved in their own report atoms and added 
to the available report group with other custom and existing generic 
reports. Generic reports remain unchanged when you create custom 
reports. You can access custom reports from the Report atom or from 
the Report Interface. The custom feature is not available for all reports.
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Guidelines for Using Sort Fields
When you display the custom section of the Report Interface, some report 
sort fields can:

! Display blank.
! Contain mandatory sort values that display in bold type.
! Contain default sort values.

Sort field values define the basic organization of a report. You can modify 
the report organization by:

! Selecting sort values in addition to these values.
! Moving mandatory or default values to different fields.
! Replacing default values.
! Deleting default values. (You cannot delete mandatory sort values.)

You also can select either ascending or descending order for any sort field, 
or decide whether a page break should occur after each group defined by 
a mandatory sort field.

Report Interface
The Report Interface displays anytime you select a print report option from 
the application menu. This screen consists of two sections:

! Print Section – for running generic system reports
! Custom Section – for creating customized reports

The Print Section of the Report Interface always displays. From here, you 
can select a report type from the list, define parameters, specify page 
setup, choose to print, and access the customization section of the screen. 
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The Custom Section of the screen displays only if you choose the Custom 
button. From the custom fields, you can select values by which to sort the 
report, and specify sort orders for the fields.

Report Interface Fields

Many SASIxp reports have eliminated the Custom button on the Report 
Interface. These reports display with tabs for the Print, Custom, and 
other groups of user selections for printing reports.

Field Name Description

Report Title Field Displays in the upper-left corner of the screen 
with the report title above it. The pop-up list 
displays the system’s generic report and any 
saved custom reports. A lower case ’us’ for 
user displays next to custom report titles. The 
pop-up list contains the Generic Report, 
which cannot be changed.

Report ID Displays the report ID assigned by the 
SASIxp educational software. Report IDs 
provide a short and quick reference to a 
report. In some cases, a report’s SASIxp ID 
may be the same as its SASI III name. The ID 
for the generic version of a report cannot be 
changed.
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Orientation Indicator Indicates whether the default page 
orientation for a report is portrait (vertical) or 
landscape (horizontal). Click Setup to change 
page orientation.

Cover Page Enables you to specify whether to include a 
cover page with a report, when selected.

Draft Print Enables you to select draft print mode for dot-
matrix printers. This is generally used to print 
on 11 x 14 paper. When you select draft print 
mode, you must also select the paper size in 
the Setup window (Macintosh) or the Control 
Panel-Printers (Windows). This prints the 
reports in the resident font for the printer, 
usually Courier 12pt. This font is much larger 
than the font used when Draft Print is not 
selected. Therefore, if you attempt to print in 
draft mode on 8 1/2 x 11 paper, some 
columns may be truncated.

Print Preview Displays the report instead of printing it, 
when selected. To view the report, click 
Preview.

On a tabbed report interface, select the 
Custom tab and then select the Screen 
option button.

Report Parameter Fields Enables you to specify the range of records 
to include in a report, for example, grade 
range, gender, and date range. You can 
specify beginning and ending parameters to 
limit data included in a report. Otherwise, 
most reports will include all data. You can 
limit data included in a report even further by 
specifying beginning data only. The program 
only includes data that matches the 
beginning parameters. Field options vary by 
report.

Setup Button Displays a screen with print setup options.

Field Name Description
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Custom Button Displays the custom section of the Report 
Interface. From here, you can enter a subtitle 
for a report, select sort fields, or enter a 
Query statement. When the custom section is 
displayed, the Custom button is replaced with 
the Generic button. Click this button to clear 
the custom section from the screen.

Save Button Saves your custom reports. The system 
stores custom reports in report atoms.

Close Button Closes the Report Interface. Keep in mind 
that simply closing the Report Interface does 
not save any data. To save changes, you 
need to use Save.

Queue Button Sends the print job to the Job Queue. The 
report is printed by the Job Queue Server so 
that your workstation does not become tied 
up while the printing occurs. You can also 
specify that printing occur at some time in the 
future.

Print Button Prints one or more hard copies of a report. 
Click Print to display the Print Control screen. 
From this screen, you can select the range of 
pages to print and other settings used by 
your printer.

Field Name Description
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Custom Reports
You can display the Custom Section of the Report Interface by clicking 
Custom. The Custom Section consists of Sort fields that specify how to 
organize data in a report. Some fields may contain required sort values 
while others are blank. Values can be selected in multiple fields for a multi-
level sort. Sort fields work in conjunction with parameter fields to produce 
the range of data specified in the designated order.

Custom Report Fields

Field Name Description

Custom Report Subtitle Enables you to enter a subtitle for a custom 
report. When you print the report, the subtitle 
displays below the generic report title. Use 
the subtitle to indicate what is unique about 
the customized version of the report. If you 
save the custom report, the Report Interface 
displays the custom report in the pop-up list 
the next time you access the report.
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Custom ID Enables you to enter your own ID for a 
custom report. Use this to run a report from 
the Atom Navigation atom. To indicate which 
generic report a custom report was derived 
from, you might want to base the custom ID 
on the generic ID. For example, if the generic 
ID is MST03, you could use MST03-A as the 
custom ID.

Sort Fields Organizes data in a report. Reports can be 
sorted on up to six fields. Use the first Sort 
field first, the second Sort field second, and 
so on. For example, if you select Grade in the 
first sort field in a student report, student 
records are organized first by grade levels. If 
you select Gender in the second Sort field, 
students records are organized by gender 
within each grade level.

A/D Fields Determines the order in which data is sorted. 
Ascending order – from first to last 
alphabetically or numerically
Descending order – from last to first 
alphabetically or numerically.

There is an A/D field for each Sort field. For 
example, if you select Grade in the first sort 
field, and you select a descending sort order, 
student records are organized from highest to 
lowest grade levels.

New Page Fields Determine whether a page break occurs after 
each group of records defined by a 
mandatory Sort field. Although there is a New 
Page field for each Sort field, page breaks 
only occur for mandatory Sort fields. If you 
select No, page breaks do not occur.

Query Statement Enables you to enter a query condition to 
define additional parameters in the Report 
Interface. For example, if you only want male 
students, enter ’Gender = M’. Note the 
condition IF is not required. Query 
statements are optional.

Field Name Description
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Printing Generic Reports

1. Open the application atom that contains the report you want to print.

2. From the atom application menu, select a generic report. The system 
displays the Report Interface with the name of the Generic Report in 
the title field.

3. To limit records in your report, type information into the parameter 
fields or select item from the pop-up lists.

4. Click Setup if you want to change page orientation or page size for the 
report.

5. Select the Cover Page checkbox if you want to print a report cover 
page.

6. Click Print to print the report immediately or click Queue to send the 
report into the Job Queue.

7. Click Close to close the Report Interface.

Saving Generic Reports in Report Atoms

1. In the report Interface, click Save. You can do this before or after 
printing. The Atom Info screen displays.

2. In the fields of the Atom Info screen, enter unique identifying 
information for the report.

3. Select the checkbox next to the Locked field to lock the Report atom.

4. Click OK to save the new report and return to the report interface or 
click Close to return to the report interface without saving the report.

Remember that Close does not delete the report atom itself. To 
remove the atom from the workspace, you need to drop it on the 
Eraser. When you close the Report Interface, you’ll see the new 
Report atom in the workspace. This is a duplicate of the atom from 
which it originated. A printer symbol displays on report atoms to 
identify them.
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Checking Alignment for Preprinted Forms
When you print reports that use preprinted forms (such as report cards, 
scan sheets, and transcript labels), the SASIxp software gives you a 
chance to ensure that the printed report aligns with the form. There are two 
ways of aligning reports, depending on whether you are using a dot matrix 
printer or a laser printer.

Dot Matrix Printer

1. Select the print option from either the report interface or from a form in 
a scanning atom. The first page prints out as a test page. The Check 
Printed Form dialog box displays.

2. Go to the printer and make sure the alignment is correct for the form 
you are using.

! If the form is not aligned correctly, adjust it in the printer and click 
Reprint in the dialog box to print another test page. Continue 
making adjustments and clicking Reprint until the form is aligned 
correctly. Then click Continue to print the rest of the job.

! If the form is aligned correctly, click Continue to print the job.

Laser Printer

To align the ‘slug’ marks on a laser scan form, follow these steps:
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1. From the Attendance Scanning atom, select Print. The Check Printed 
Form displays.

2. Place the mouse pointer on the Reprint button and press the Control 
key (Windows) or Command key (Apple) at the same time. An 
alignment dialog box displays.

"+" values move the printed areas down or to the right

"-" values move it up or to the left

3. Each value "+" or "-", offsets the mark approximately 1/100 of an inch 
in the appropriate direction, but different printers can offset the printed 
marks in slightly different increments. You can keep entering values in 
this window until the “slug” marks are centered exactly in the 
appropriate circles, boxes, brackets, or bubbles.

4. Select Continue to finish printing the scanner forms once the marks 
are lined up properly. The system remembers these settings and it will 
not have to be done again unless a different form is used.

Customizing Reports
You can customize any generic report by modifying parameters, sort order, 
or by adding a subtitle. If you want to reuse a customized report version, 
save it in a report atom. Any custom report you save is added to the report 
group for the generic report. You can then access a custom report from 
either the report atom or from the report interface.

For example: A +10 in the Vertical field and a +30 in the Horizontal 
field will change the alignment of the printed marks down and to the 
right.
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Creating Custom Reports

1. From the atom application menu, select the generic report that you 
want to modify. The report interface displays.

2. In any parameter field, enter parameters to limit the range of records 
included in the report.

3. Click Setup if you want to change page orientation, reduce page size, 
or specify other printer settings.

4. Click the Cover Page check box to print a report cover page.

5. Click Custom to display the custom section of the report interface.

6. In the Subtitle field, type a custom report name.

7. In the Custom ID field, enter an ID for the custom report.

8. In the Sort fields, select sort values for the report.

! If the field contains a mandatory value that is bold, that value and 
any values in the fields that follow shift one field to the right.

! If the field contains a default value, the value is replaced by the 
value you select.

9. In the A/D fields next to the Sort fields, select ascending or descending 
sort order.

10. In the New Page fields, select No – no page breaks, or Yes – page 
breaks, for mandatory sort fields.

11. In the Query Statement field, type a query statement if you want to use 
one in addition to parameters. The system assumes IF in the 
statement so you do not have to type it.

12. Click Print to print the report immediately or click Queue to send the 
print job to the Job Queue.

13. Click Close to exit without saving the custom report.

If you want to save the custom report, click Save before or after you 
print the report. The Atom Info screen displays.

14. Enter information in the available fields—name, short name, 
description, hot key—of the Atom Info screen.

15. Select the Locked check box to lock the Report atom in place.

The recommended orientation indicator at the top of the report 
interface displays the recommended report orientation.
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16. Click OK to save your data and return to the report interface (or click 
Close to return to the report interface without saving data in Atom Info).

Remember that Close does not delete the report atom itself. To 
remove the atom from the workspace, you need to drop it on the 
Eraser. When you close the report interface, you’ll see the new Report 
atom in the workspace. This is a duplicate of the atom from which it 
originated. A printer symbol displays on report atoms to identify them.

Printing Existing Custom Reports

1. Double-click the Report atom for a custom report. (You can also go to 
the atom application menu and select the generic report, then select 
the custom report from the Title field in the report interface.) The report 
interface displays.

2. Select parameters in available parameter fields.

3. Click Custom to change sort order. See Creating Custom Reports. 
Click Setup to display the Printer screen to change page orientation, 
reduce page size, or specify other printer settings.

4. Select the Cover Page check box to print a report cover page.

5. Click Print to print the report immediately or click Queue to send the 
print job to the Job Queue.

6. Click Close.

The recommended orientation indicator at the top of the Report 
Interface displays the recommended report orientation.
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Sending Reports to the Job Queue
The report interface includes a Queue button that enables you to send 
print jobs to the Job Queue so that you can continue using the SASIxp 
educational software without waiting for a report to print. You have several 
options for scheduling print jobs to process, for example, during the 
evening when no one uses the printer.

Job Queue Option Fields

Field Name Description

Priority

Urgent Processes ahead of all other jobs in the 
queue.

Normal (Default) Processes in the order received.

Recurring Process as a recurring pattern job. This 
selected option displays the Pattern Name 
field from which you can select or create a 
recurring pattern.
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Pattern Name Recurring pattern for the print job. Select 
from a list of existing patterns or create a new 
pattern with the Create… item.

Time Delayed Specifies the date and time that the report is 
created and printed.

Notify Me

By mail Sends a message to your In folder.

By Alert Displays an alert on the screen with the 
status of the printing job.

Job Title Title of the report being sent to the queue.

School Range Enables you to queue a report for a range of 
schools. The default in both the From and To 
fields is the number of the school you are 
logged into. To print a range of schools, 
select the appropriate school numbers in the 
From and To fields.

School Type Enables you to select one school type to use 
for the defined range:

! All school types
! Secondary
! Elementary, no schedules
! Elementary, with schedules

Send to Server Enables you to select one of the available job 
queue servers from the list of servers defined 
in the Tables Definition atom.

Field Name Description
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Creating Job Queue Patterns

The Job Queue Patterns atom (in the Utilities folder) enables you to create 
a recurring pattern to process repeat print jobs.

Job Queue Patterns Screen
The Job Queue Patterns atom enables you to create multiple repeating job 
print patterns. The Job Queue Patterns screen displays when you open 
the Job Queue Patterns atom. It also displays from the Job Queue 
Manager when you select the Recurring print job option and choose to 
create a new recurring pattern.

When you access the Job Queue Patterns atom from the Job Queue 
Manager, you can only add patterns. To modify or delete job queue 
patterns, or perform any other tasks with the atom, you must open the 
Job Queue Patterns atom directly.
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Job Queue Patterns Fields

Field Name Description

Pattern Name The name of this job queue pattern. When 
you save the pattern and select the Recurring 
option on the job queue form, the pattern 
name displays on the pop-up list of available 
pattern names.

Description The brief description of the job queue pattern.

Daily Repeat Pattern

Daily Processes the task once each day, or once 
per set number of days.

Every __ Day(s) Processes the task every set number of days. 
For example, type a 1 in this field to process 
a task every day, or type 3 to process the task 
every third day.

Every Weekday Processes a task daily Monday through 
Friday.

Weekly Repeat Pattern

Weekly Processes the task on a particular day each 
week, or once per set number of weeks.

Repeat every __ 
week(s) on __

Processes a task once every set number of 
weeks on specified days. For example, you 
can choose to generate student report cards 
every 9 weeks on Friday.
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Using the Job Queue Patterns Atom

Use the Job Queue Patterns atom to add, delete, or modify a recurring 
pattern, and to change a pattern name or the description of a job queue. 
See Data Menu Functions.

Inactivating a Recurring Pattern

If you no longer want the system to process a recurring pattern, but you do 
not want to delete it from the job queue permanently, you can inactivate it.

Monthly Repeat Pattern

Monthly Processes the task on a particular day on a 
monthly basis, or once per set number of 
months.

Day __ of every 
__ month(s)

Processes a task on a specific day every set 
number of months. For example, you can 
choose to generate progress reports on day 
10 of every 2 months.

The __ __ of 
every __ month(s)

Processes a task on a specific weekday 
every set number of months. For example, 
you can choose to generate parent letters on 
the 2nd Wednesday of every 2 months.

Range of Repeat

Start The date the recurring process begins. The 
default is the date you create the pattern.

End Date options No End Date –The system continues to 
process the task regularly from the start date 
onward.

End After: __ 
Occurrences – The 
system stops processing 
the task after a specific 
number of occurrences.

End By: __ – Specifies a date after which the 
task no longer repeats.

Field Name Description
Copyright © 2000–2004 Pearson Digital Learning Job Queue Patterns Screen  55



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
1. Open the Job Queue Patterns atom.

2. Find a pattern name to inactivate.

3. From the Data menu, select Inactivate Pattern. Brackets enclose the 
pattern name at the top of the screen, indicating that the pattern is 
inactive.

4. Click Close.

Activating an Inactive Recurring Pattern

This procedure enables you to reactivate an inactive pattern so the system 
processes it on a recurring basis.

1. Open the Job Queue Patterns atom.

2. Find the inactive pattern name that you want to activate. Brackets 
enclose inactive patterns.

3. From the Data menu, select Activate Pattern. The pattern name 
displays without brackets, indicating that the pattern is active.

4. Click Close.

SASIxp Terminology

Term Definition

Alias Represent an atom or folder stored in 
another part of the desktop, and serves as a 
shortcut to opening the atom or folder. 
Aliases are docked in toolbars.

Atoms Basic program component used to run 
applications and open data screens.

Application Atoms Program-generated atoms that open 
applications, menus, screens.

Data Atoms User-generated atoms for saving a record 
used extensively. Can be dropped onto other 
atoms to open them and automatically 
display data on the entity in the Data atom.

Filter Atoms User-generated atoms for saving data filters.
56  SASIxp Terminology Copyright © 2000–2004 Pearson Digital Learning



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Query Atoms User-generated atoms for saving queries.

Report Atoms User-generated atoms for saving reports.

Briefcase Icon that represents a folder.

Desktop The total SASIxp environment, including the 
Toolbar, Message Center, Menu Bar, and 
Workspace.

Docking Term used for positioning an atom alias in a 
toolbar.

Folders Briefcase icons that represent storage areas 
for atoms and other folders.

Link Arrows Small arrows in atom screens that provide 
links to other atoms.

Menu Bar Horizontal bar at the top of the desktop 
displaying the File, Edit, Windows, Data and 
Help (Windows) Menus, and any application 
menu associated with the atom currently 
active.

Message Center Horizontal bar at the base of the desktop with 
four message areas displaying messages on 
fields and functions.

Object Any item or group of items on the SASIxp 
desktop that can be moved by dragging and 
dropping, such as an atom, folder, or field 
within a screen.

Records Related pieces of information within a data 
file. For example, each record in the Student 
file represents one student, and each record 
in the Health Incident file represents one 
incident for an individual student.

Toolbar Vertical bar on the left side of the desktop 
with docking areas for atom aliases.

Workspace The largest part of the desktop and the area 
in which you work with applications and data.

Term Definition
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Enrolling Students

Use the Enrollment atom (in the Student Info folder) before entering 
student information or using other student-related functions in the 
SASIxp™ software.

As you enter and save basic data, the SASIxp software automatically 
creates the Student records and Attendance records where you can enter 
data for each enrolled student. You can create records in other student-
related atoms as needed.

Using Enrollment Screens
Use the two Enrollment screens to add or modify student data. See Data 
Menu Functions.

! Current Screen
! History Screen

The Enrollment Validation Definition atom is in the System Setup folder. 
This atom enables you to validate student data during the student 
enrollment process using validation rules defined by your school or 
district.
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Current Screen

The Current screen enables you to add and inactivate students, and 
update enrollment records with the latest changes in a student’s 
enrollment status.

Current Fields

This atom contains standard header fields for student information within 
your school. The chapter, Standard SASIxp Header Fields, defines header 
fields for this and other atoms. The standard header fields in this atom 
begin with Last Name and end with Student ID.

Field Name Description

Last Name Student’s last name.

First Name Student’s first name.

Middle Name Student’s middle name.

Gnrtn Student’s generation code, such as Jr. or Sr. 

Grd Student’s grade.

Gen Student’s gender.
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Trk Attendance track to which a student is 
assigned. This field only displays in schools 
using a track schedule.

Student ID Student’s ID number.

Enter Date Most recent date the student enrolled at your 
school. The system records any previous 
enrollment dates in the Enrollment History 
matrix. Although you can enter a date prior to 
the first date in the Attendance Calendar, 
Attendance Totals only reflect data entered 
on or after the first date in the Calendar.

Enter Code
(ENT table)

Code indicating the circumstances under 
which a student enrolled at your school. If the 
school defined a default code in the School 
atom, this displays here automatically when 
you enroll a student.

Leave Date The date a student left your school. The 
system records any previous leave dates in 
the Enrollment History matrix. If you enter a 
future date, the program does not inactivate 
the student until that date. The Leave Date is 
either the last day of enrollment or the first 
day of non-enrollment, depending on how the 
school is set up.

Leave Code
(LVE table)

Code indicating the circumstances under 
which a student left your school. If the school 
defined a default code in the School atom, 
this code displays automatically when you 
inactivate a student.

Field Name Description
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IS Code
(SET table)

Instructional Setting code that flags a student 
as participating in a special program where 
attendance needs to be reported separately, 
such as Special Ed. All students tagged with 
a specific Instructional Setting code in the 
Enrollment atom are grouped together in 
Monthly Attendance by Student and Monthly 
Attendance Summary Reports. This field 
displays only if it has been identified as a 
Data Change Affecting Enrollment on the 
Enrollment page of the School atom.

Sch School number for the school a student 
attends. In most cases, this number is your 
school’s number from the School atom. 
Usually, this number is the system default. If 
the student attends more than one campus, 
the home school displays.

Dst Number of the school district in which a 
student resides.

Tch Teacher number for the teacher to whom a 
student is assigned. This number can be the 
student’s advisor or homeroom teacher. At 
Daily Attendance schools, this teacher’s 
class is the one used for attendance. Teacher 
numbers entered here automatically display 
in student records in the Student atom. This 
field displays only if it was selected in the 
School atom as a Data Change Affecting 
Enrollment.

Teacher Name Name of the teacher to whom a student is 
assigned. The system completes this field 
automatically when you select a Teacher 
Number and exit that field. If your school is 
set up as an elementary school without 
schedules, the system builds class lists from 
the Teacher data here. This field displays 
only if it was selected in the School atom as a 
Data Change Affecting Enrollment.

Field Name Description
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ADA Enables you to indicate a student’s eligibility 
for ADA. The system defaults to Y.

! Y = Yes
! N = No
! A = Half Day a.m.
! P = Half Day p.m.
! M = Full Day a.m.
! E = Full Day p.m.
! C = Concurrent means concurrently 

enrolled. Use this code only for district 
integration.

Effective Date Date that a change to a student’s enrollment 
status becomes effective. When you enroll or 
inactivate a student, the date in the Enter 
Date or Leave Date field is entered 
automatically in the Effective Date field. What 
happens when you make other changes 
depends on the setup in the School atom. If 
you select Enable automatic update of 
effective dates, the program automatically 
enters the current date as the Effective Date. 
If you select Disable automatic update of 
enter dates, you need to enter the date.

User Codes Fields for school-defined codes used to track 
information that affects enrollment. Only user 
codes that require the tracking of Enter or 
Leave data for attendance purposes are 
included here. These codes are defined as 
data changes affecting enrollment on the 
Enrollment tab in the School atom.

Field Name Description
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No Show Use this button to inactivate the records of 
students who enroll at school but do not show 
up during registration. If a student already 
has a schedule and you click No Show then 
Save, the system displays a message 
prompting you to choose the method you 
want for handling the student’s class 
information.

! Delete – The system permanently 
removes the student’s classes from the 
current schedule, and does not record the 
student in class history.

! Drop – The system permanently removes 
the student’s classes from the current 
schedule. The classes are tagged with an 
N code so you can identify them if the 
student reactivates. 

Note: Select Drop if you might want to later 
restore classes for a No Show student.

! Retain – The student’s classes are 
unchanged.

To reactivate a No Show student, use the 
Activate function on the Data menu.

If any class history classes are tagged N, the 
system displays a message indicating the 
student has dropped courses, then asks if 
you want to restore the student’s schedule.

! Select Yes to reactivate the student and 
move the classes from class history to the 
student schedule file.

! Select No to reactivate the student and 
have the previous classes remain in class 
history.

Field Name Description
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Enrolling Students

In addition to enrolling students, you can use the Enrollment atom to 
update enrollment records with new data such as changes in teachers or 
instructional settings. You also can work from this atom to revise 
enrollment histories, change the Name/ID line, and to inactivate, 
reactivate, or delete students. See Data Menu Functions.

You must have Security Officer rights, or have been assigned rights in the 
User atom, by a Security Officer, to access the Delete Student option on 
the Data menu. If you don’t have these rights, the option is dimmed. 

These data fields are required to enroll a student:

! Last Name
! First Name
! Gender
! Grade
! Enter Date
! Enter Code

After you save a student enrollment record, you can open a Fast Access 
atom and enter other data related to that student or you can add another 
student enrollment record.

Enrolling New Students

1. Open the Enrollment atom.

2. From the Data menu, select the Add Student option. The number of the 
school you are logged into displays in the Sch field and the current 
date displays in the Enter Date fields. (Asterisks display in the Student 
ID field if your school has set up this field for automatic entry of 
permanent numbers.)

3. In the Last Name, First Name, Middle Name, and Gnrtn fields, type the 
student’s name information. (The Middle Name and Gnrtn fields are 
optional.)

4. In the Grd field, select the student’s current grade from the pop-up list.

5. In the Gen field, select the student’s gender from the pop-up list.

6. In the Trk field (if displayed), select the student’s track assignment from 
the pop-up list.
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7. In the Student ID field when there are no asterisks, type a permanent 
student identification number. (The system alerts you to duplicate IDs 
at your school only.)

8. Review the Enter Date field and change the default enrollment date. 
(Remember that Attendance totals do not reflect data for enrollment 
dates prior to the first date in the Attendance Calendar.)

9. In the Enter Code field, select a code from the pop-up list if the system 
does not automatically supply a default code.

10. If the IS field displays, select an instructional setting from the pop-up 
list.

The system automatically enters your school number in the Sch field.

11. In the Dst field, type your school district number.

12. If the Tch field displays, click the Link Arrow to display the teacher list 
from the Teacher List atom (this remains open). For subsequent 
students, click the Teacher list to move it to the front of the Enrollment 
form. Drag and drop the teacher number to the Tch field. The teacher 
number displays and the system automatically enters a name in the 
Teacher Name field.

13. Skip the Effective Date field because the system automatically 
supplies data when you save the record.

14. In the first User Code field (if displayed), select a user code from the 
pop-up list. (Only user codes that were identified in the School atom 
and that affect student enrollment are available.)

15. Click Save. Saving the record automatically adds a line of history to the 
Enrollment History matrix and creates a record in the Student file and 
the Daily or Period Attendance files.
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History Screen

The History screen enables you to review and revise each student’s 
complete enrollment record for a specific school year. Use the Change 
Enrollment History option on the Enrollment menu to unlock the fields on 
the History screen.

History Fields

Field Name Description

Ln Line number for each row.

Effective Effective date for each change in a student’s 
enrollment status, including changes in 
grade, teacher, IS, and so on.

Enter Enter code selected for each enrollment date 
in the student’s history at your school.

Leave Leave code selected for each leave date in 
the student’s history at your school.

Yr Year of the student’s enrollment.

Sch# Number of each school a student has 
attended. In most cases, this number is the 
same as the number for your school.
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Activating and Inactivating Students

You can work from the Enrollment atom to delete, inactivate, or activate 
students using options on the Data menu. The Inactivate option on this 
menu changes to Activate when an inactive record displays.

These data fields are required to activate a student:

! Leave Date
! Leave Code

Grd Student’s grade level at the time of each 
enrollment status change.

Trk Each new student track assignment.

IS Each student Instructional Setting Code 
change.

Tch Teacher number for each new teacher to 
whom a student is assigned.

Tch Name Teacher name for each teacher to whom a 
student is assigned.

ADA Enables you to indicate a student’s eligibility 
for ADA. 

! Y = Yes
! N = No
! A = Half Day a.m.
! P = Half Day p.m.
! M = Full Day a.m.
! E = Full Day p.m.
! C = Concurrent means concurrently 

enrolled. This code is used only for 
district integration.

The default is Y for all students.

Field Name Description
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Inactivating Student Records

1. Open the Enrollment atom and display the Current screen.

2. Locate the student’s record.

3. From the Data menu, select Inactivate Student. By default, the system 
enters the current date in the Leave Date field. As necessary, you can 
manually change the date.

4. In the Leave Code field, select a code from the pop-up list. The system 
may automatically enter a default leave code depending on your 
school’s setup.

5. Click Save to inactivate the student. In all Student atoms, parentheses 
display around a student’s name to indicate inactive status.

Reactivating Records

1. Open the Enrollment atom and display the Current screen.

2. Locate the student’s record.

3. From the Data menu, select the Activate Student option.

! The system erases data in the Leave Date field.
! The system also enters the current date in the Enter Date field but 

you can change this manually if necessary.
! The system maintains the student leave data and continues to 

display it in the Enrollment History screen.

4. In the Enter Code field, select a code from the pop-up list if the system 
does not automatically supply a default code.

5. Click Save to reactivate the student. In all Student atoms, parentheses 
disappear from around a student’s name to indicate active status.

Marking Students as No Shows

1. Open the Enrollment atom and display the Current form.

2. Locate the student’s record.

If your school is set up as an elementary school with schedules or as 
a secondary school, the system displays a dialog box asking if you 
want to drop the student from all classes.
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3. Click No Show. The system puts parentheses around the student’s 
name to indicate that the student is inactive, and puts an ‘n’ in the 
status field in the ASTU file

4. Click Save. The system displays a dialog box.

5. In the dialog box, select a method for handling student classes:

! Delete – Permanently delete the student’s classes from the current 
schedule.

! Drop – Delete the student’s classes from the current schedule but 
save the classes as history. You can reactivate the classes later.

! Retain – Leave the student’s classes unchanged.

Deleting Student Records

1. Open the Enrollment atom and display the Current form. (The Delete 
function is available only from the Current form in the Enrollment 
atom.)

2. Locate the student’s record.

3. From the Data menu, select Delete Student. The system display a 
dialog box with two buttons.

4. Click OK to delete the student from the system. All data associated 
with that student in all Student atoms is permanently removed.

OR

Click Cancel to not delete student data.

The No Show button displays only if you activate it in the No Show 
field on the Enrollment page of the School atom.

When you mark a student as a No Show, the system automatically 
deletes any active service programs in which the student is enrolled. 
The system does not delete any service program history records that 
contain exit date and reason data.
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Enrollment Atom Menu Options

Options on the Enrollment menu enable you to unlock the fields on the 
history matrix so you can perform changes to student enrollment data. 
Normally, schools lock enrollment fields to prevent accidental change.

Another Enrollment menu option enables you to display or hide dots 
beside Fast Access atoms that contain records. Dots indicate that data 
has been entered in an atom for the selected student.

Changing Data in the Name...ID Line

1. Open the Enrollment atom and display the Current screen.

2. Locate the student record that you want.

3. From the Enrollment menu, select Change Name...ID Line.

4. Go to any fields that you want to change. Type new date or select a 
different item from the pop-up list.

5. Click Save.

Changing Enrollment History

You can unlock the Enrollment History matrix and modify and delete data.

1. Open the Enrollment atom and display the History page.

2. From the Enrollment menu, select Change Enrollment History.

3. Go to any fields that you want to change. Type new data or select a 
different item from the pop-up list.

To delete a line of enrollment history, click the Ln number for the row to 
be deleted. Make sure the row is highlighted. (The first row cannot be 
deleted because it displays a student’s original enter date.)

4. Click Save.

Show Student Data

You can identify the Fast Access atoms that contain records for the current 
student.

! To automatically display dots next to Fast Access atoms for all 
students, select the Show Data Exists in Enrollment option in the User 
atom.
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! To search records quickly, use the Show Student Data option to 
temporarily deactivate the dot feature. Once you find a record, select 
Show Student Data again to display the dots.

Fast Access Atoms

The Enrollment atom also enables you to access quickly all the atoms that 
your school defines as critical to maintaining essential student data. These 
atoms display in a list on the Enrollment screen and are opened using Link 
Arrows.

Adding Supplemental Data the Fast Access Way

1. Open the Enrollment atom and display the Current page.

2. Locate the student’s record.

3. Click the Link Arrow for any Fast Access atom. The first page in the 
selected atom displays with the top line completed with header data 
from the Enrollment atom.

4. Go to fields in which you want to record information. Type data or 
select an item from the pop-up list.

5. Click Save.

6. Click Close to return to the Enrollment atom.

You must save a student’s basic data from the Enrollment atom before 
you can work within other atoms to add information about the student.
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Defining and Using Student Demographics

Student Atom
The Student atom (in the Student Info folder) enables you to enter, 
maintain, and view demographic data for students at your school. The 
Student atom consists of three tabs and accepts information that becomes 
part of the student’s unique records.

All fields within the three tabs of the student screen are optional. You can 
enter data depending on the information available and the needs of your 
school. Student labels, rosters, and reports are generated based on data 
from the student screen. You can return to the student screen as often as 
necessary to update data. See Data Menu Functions.

Use the three Student tabs to add or modify student data:

! Student Page 1
! Entering Student Data
! Student Page 3
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Student Page 1

Student Page 1 Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.
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You can change this data using one of two atoms within the SASIxp™ 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

Address Student’s residential and mailing address. If 
street validation is turned off in the School 
atom, the mailing address fields display by 
default. If street validation is turned on in the 
School atom, the residence address is the 
default and the system validates the street 
address of this student.

! If the student lives within the school 
enrollment area, the system completes 
the residence city, state, postal code, grid 
code, and bus stop information from the 
data in the Street file.

! If the student does not live within the 
school enrollment area, the system 
prompts you to enter an attendance 
permit code and date.

To enter a fractional address, such as 1055 ½ 
E. Main, type 1055 1/2 (including the slash). 
Decimal point entries are not valid.

City City portion of a student’s address.

St State portion of a student’s address.

Zip Code Zip code portion of a student’s mailing 
address. Type a hyphen if you include the 
4-digit extension.

Parent/Guardian Name Name of the primary parent or guardian. This 
name should match the parent or guardian 
identified as the responsible adult in the 
Parent Guardian atom.
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Family ID ID number that enables you to link siblings at 
the same school. Locate siblings using the 
Sibling atom. See Establishing Sibling 
Records. The system assigns the same 
family ID to each sibling when you use the 
Sibling atom.

Telephone Student’s home phone number. Type number 
with or without spaces. The system inserts 
hyphens.

UnL Indicates whether a student’s home phone 
number is listed or unlisted in the student 
directory.

Country The province in which the student resides. 
Displays if the Province check box is selected 
on the Localization screen of the School 
atom. See Defining and Using Student 
Demographics.

Birthdate Student’s date of birth.

Soc Sec No. Student’s Social Security Number. Type 
number with or without spaces. The system 
inserts hyphens.

Eth
(ETH table)

Student’s ethnic code.

ConcSch/Home Displays two data fields:

! ConcSch is the number of any school a 
student attends concurrently with the 
home school, such as a continuation 
school or school for the handicapped.

! Home enables you to indicate whether the 
concurrent school is the home school. A 
selected box indicates that the concurrent 
school and home school are the same. 
These fields cross-reference students with 
records at multiple schools.

Field Name Description
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Bus 1 and Bus 2 Information on buses used by students, such 
as the number of the bus a student takes or 
the number of his or her bus route.

Enter Date Date a student entered your school. If a 
student has re-enrolled, the most recent 
Enter Date displays. The system enters data 
from the Enrollment atom. The field is locked 
on the Student atom.

Code
(ENT table)

Indicates the circumstances under which a 
student enrolled at your school. If a student 
has re-enrolled, the most recent Enter Code 
displays. The system automatically enters 
data from the Enrollment atom. The field is 
locked on the Student atom. See Defining 
and Using Student Demographics.

Leave Date Date a student left your school. The system 
automatically enters data from the Enrollment 
atom. The field is locked in the Student atom.

Code
(ENT table)

Indicates the circumstances under which a 
student left your school. The system 
automatically enters data from the Enrollment 
atom. The field is locked in the Student atom.

OrgEntDate Original Enter Date for the first time a student 
enrolled at your school. This date differs from 
the date in the Enter Date field if the student 
has enrolled at your school more than once. 
The system automatically enters data from 
the Enrollment atom, but you can change it.

Code
(ENT table)

Original Enter Code for the first time a 
student enrolled at your school. This code 
may differ from the code in the Enter Code 
field if the student has enrolled at your school 
more than once. Data is entered here 
automatically from the Enrollment atom. You 
can override it by selecting an item from the 
pop-up list of school-defined Enter Codes.

Field Name Description
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EntGrd Student’s grade at the first time of enrollment 
at your school. The system automatically 
enters data from the Enrollment atom. See 
Enrolling Students.

Yr/Grad Student’s year of graduation. The system 
automatically completes this field based on 
the student’s grade at the time of enrollment 
(but this year can be changed later). This 
information prints in the Class Of field on 
transcripts.

Tchr# (Advsr#) Teacher number for the teacher currently 
assigned to a student. If the teacher is 
flagged as a data change affecting 
enrollment on the School atom, the system 
automatically enters data from the Enrollment 
atom. See Enrolling Students.

Name Name of the teacher currently assigned to a 
student. The system automatically enters 
data from the Enrollment atom.

Room# Number of a student’s current homeroom.

Couns# Number of the guidance counselor assigned 
to a student or of the teacher assigned as a 
guidance counselor.

Name Name of the guidance counselor assigned to 
a student.

ESL
(ENG table)

Indicates a student’s proficiency level in 
English.

IS
(SET table)

Instructional Setting code indicating any 
special program in which the student is 
enrolled. The system automatically enters 
data from the Enrollment atom if the field has 
been identified as a change affecting 
enrollment.

Effective Date Indicates date of any change to enrollment.

Field Name Description
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Entering Student Data

All fields within the pages of the student screen are optional. You can enter 
data depending on the information available and the needs of your school. 
Student labels, rosters, and reports are generated based on data from the 
student form. You can return to the student screen as often as necessary 
to update data.

Completing Student Records from the Student Tabs

1. Open the Student atom and display Student Page 1.

2. Locate the student record.

3. In the Address field on Page 1, enter the student’s mailing or 
residential address.

If the street validation feature has been turned on in the School atom, 
the system automatically supplies information to the remaining 
address fields for students who live in the enrollment area. For 
students who do not live in the enrollment area, the system prompts 
you to enter an attendance permit code and date.

If the street validation has not been turned on in the School atom, you 
need to manually enter data in all address fields.

4. For the remaining fields on Student Page 1, type data or select an item 
from the pop-up list.

5. When you finish entering data on Page 1, display Student Page 2.

6. For all fields on Student Page 2, type data or select an item from the 
pop-up list.

7. When you finish entering data on page 2, display Student Page 3.

8. For all fields on Student Page 3, type data or select an item from the 
pop-up list.

The SASIxp software accepts fractional addresses, such as 1055 1/
2 E. Main Street. To enter this fractional address, type 1055 1/2 
(include the slash) and the system converts the number to a fraction. 
Decimal point entries are not valid.

If you type an address fraction without a separating space, the 
system inserts the space for you. For example, if you type 9871/2 
West, the system converts the address to 987 1/2 West when you 
click Save.
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9. In the check boxes that display on the lower half of Student Page 3, 
select each condition that applies to the student.

Next to the DrvTrnElig check box is a date field where you must enter 
the date on which a student is eligible for driver training if you select 
the DrvTrnElig check box.

10. Click Save to save data entered on all tabs of the Student screen.

Student Page 2

Student Page 2 Fields

Field Name Description

Birthplace Student’s place of birth.

Verif Indicates whether the student has provided a 
document verifying place of birth.

Alias Name Any alternate last name the student uses 
instead of his or her given name.

Nick Name Any nickname by which the student is known.
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Locker Number of the student’s main locker.

Alt Locker Number of an additional locker assigned to 
the student.

Dst/Res Number of the school district in which the 
student resides.

Sch/Res School number for the school near which the 
student resides. The system enters this 
number with information from the Enrollment 
atom. In most cases, this number is the same 
as the number for your school. It differs when 
a student from outside your district, or from a 
different area within your district, has been 
allowed to attend your school.

Grid# Displays the geographic grid number 
indicating the location of the student’s 
residence.

Sumr Schl School number for the school at which the 
student attends summer classes.

Apport% Percentage of full-day apportionment 
allowed, based on student attendance.

NxtSch Number of the next school the student is 
scheduled to attend after leaving your school. 
This field is used as part of the end-of-year 
procedures for students in the highest grade 
level in the current school.

NxtGrd Enables you to indicate next year’s grade 
level for students who are promoted more 
than one grade or held back.

NxtTrk Number for the next attendance track 
assignment for the student. This field is used 
as part of end-of-year procedures if the 
student’s track changes next year.

Field Name Description
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LstSch Number of the school the student attended 
last. The Feeder School Option of New Year 
Rollover process automatically completes 
this field.

PostSec
(PST table)

Code indicating the student’s post-secondary 
plans.

Ctz Code indicating the student’s citizenship 
status.

PrimLang
(LNG table)

Language in which student is most fluent.

HomeLang
(LNG table)

Language spoken in a student’s home.

CorrLang
(LNG table)

Language in which letters to a parent or 
guardian should be written.

Program Indicates whether the student is enrolled in a 
special program, such as LEP or other 
program.

! X = Yes
! Blank = No

Permit Cd
(ATP table)

Attendance permit code for permit that allows 
a student from another school (in or out of 
your district) to attend your school.

Note: The system clears this field if the 
student’s address is within the district 
boundaries during street validation.

Date Date the attendance permit was issued.

Grad Date Actual date that the student graduated. This 
date defaults from the effective date entered 
on the Graduate Students screen in the New 
Year Rollover atom, or you can enter it 
manually.

Field Name Description
82  Student Atom Copyright © 2000–2004 Pearson Digital Learning



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Student Page 3

Student Page 3 Fields

EOY Status
(EOY table)

End of year status is a state-specific field that 
indicates the student’s status at the end of 
the year; for example, C for completed, G for 
graduated, R for retained, and P for 
promoted.

Field Name Description

Field Name Description

User Codes 1-9 Fields for all user codes defined by the 
school and state for tracking student 
information. You can display up to nine user 
codes (UC1–UC9).

User Num 1-5 You or your state can define a number for 
tracking student information (UC11–UC13).
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Meals
(FRL table)

Indicates whether the student participates in 
the Free and Reduced Meals Program.

Alternate ID 1 & 2 You can use these fields for the first and 
second alternate IDs assigned to the student.

Disciplinary User Code Code populated from the ASTU file in the 
Student atom, which is not an input file in 
ADIS. This is a read-only field.

Foster Home Indicates whether the student resides in a 
foster home.

Homeless Indicates whether the student is homeless.

Gifted & Talented Indicates whether the student is in the Gifted 
and Talented program (GATE).

Migrant Indicates whether the student lives with a 
migrant family.

PE Waiver Indicates whether the student is excused 
from taking physical education.

Restrict Pers. Info Indicates whether the student’s personal data 
can only be released to the primary parent or 
guardian.

Refugee/Immig Indicates if the student is a refugee or 
immigrant.

Retain Indicates whether the student has been 
retained.

DrvTrnElig - Date Indicates whether the student is eligible for 
driver’s training. If this check box is selected, 
you also need to enter the date the student 
becomes eligible in the Date field.

Receives Financial Aid Indicates whether the student is eligible to 
receive financial aid. This field is used by the 
Tuition atom.

No Auto Dial Indicates whether phone calls to the 
student’s home should not be made by an 
auto dialer.

Field Name Description
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Adding New Students from Student Atom

You can easily add a new student enrollment record while working from an 
existing student record in the Student atom. Open the Enrollment atom (by 
selecting Add Student from the Data menu) and perform work in it while 
the Student atom remains active in the background. When closing the 
Enrollment atom, the system return you to the same student record that 
you left in the Student atom.

1. Open the Student atom.

2. From the Data menu, select Add Student. The system opens the 
Enrollment atom and displays a blank enrollment screen.

3. Enroll the student.

4. When you finish working from the Enrollment atom, click Close to 
return to the student record that you left in the Student atom.

Student Menu Reports

Comp Ed Indicates whether the student participates in 
a Compensatory Education program.

Field Name Description

Report Name Description

Enrollment Report
(STU12)

Reports the number of students assigned to 
each teacher. No custom sort fields are 
available for this report.

Three Across Student 
Directory
(STU01) 

Produces a student directory indicating 
student name, gender, grade level, and birth 
date.

Student Directory
(STU02)

Produces a list of the students enrolled in the 
currently active school.

Name and Address 
Labels
(STU03)

Produces labels for mailings to parents. Each 
label includes parent or guardian name, 
student name, address, and a comment text 
field.
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Class Rank and GPA
(STU05)

Prints a list of students indicating their current 
class rank in alphabetical order or by class 
rank.

Schedules
(STU07)

Prints a list of all students on file and their 
current class schedules.

Add-Drop Listing
(STU08)

Provides a list of students to be added to, or 
dropped from, class rosters or attendance 
scanner sheets. Teachers can use this list to 
update their attendance forms.

Data Labels
(STU09) 

Produces labels displaying a variety of 
student data including student name and ID, 
grade level, gender, enrollment date, parent 
or guardian name, home phone, and home 
address.

Name and School
Labels
(STU21)

Produces labels displaying school name, 
student name, and grade level (but no 
address).

Birthday Listing
(STU25)

Provides a list of student birthdays including 
day of month, student name, age, and 
address.

Locator Cards 2-Across
(STU31)

Produces locator cards in index card format. 
Data includes parent or guardian name, 
home phone, enrollment date, address, 
student name and ID, birth date, gender, 
grade level, name of school, today’s date, 
and counselor name.

Locator Card 1-Across
(STU32)

Produces locator cards to accommodate 
split-week schedules and can be printed 
using the SASI-0036 form.

Class Rosters/
No Schedules
(STU40)

Produces a roster of students organized first 
by teacher then by grade level. This report 
option is dimmed unless displaying the 
Student List.

Report Name Description
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Class Rosters/
With Schedules
(STU41)

Produces a roster of students organized first 
by teacher then by section numbers within 
each grade level. Data includes student 
name and ID, home phone, teacher number, 
and teacher name.

Special Class List
(STU43)

Lists students for each section, period, 
course or grade, and teacher. Each row 
includes student information and a space for 
comments at the end of the row.

Grid Distribution
(STU97)

The number of students for each point on the 
district or school’s geographic grid.

Ethnic Distribution
(STU98)

Provides a report indicating a school’s ethnic 
distribution by grade level and gender. The 
report prints numerically in ascending order 
by grade.

Duplicate ID List
(STU47)

Indicates all students who have duplicate 
numbers in the site and server files if district 
integration is used.

Demographic Report 
(STU30)

Displays pupil count information required by 
the State of California for California Basic 
Educational Data System (CBEDS).

Student Master List
(STU10)

Displays student name, grade, homeroom, 
teacher name and number, emergency 
phone number, home phone number, 
address, parent or guardian relationship, 
parent or guardian first and last name, and 
work phone number and extension.

Student Register
(STU45)

Summarizes student information, parent or 
guardian contacts, and course schedules for 
use by personnel who don’t have access to 
the SASIxp educational software. The report 
is sorted by student name.

Report Name Description
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Student Menu Options

Attaching Student Photos

Use the Attach Student Photo option to attach a photo to Page 1 of the 
Student screen. The student’s photo then displays in the photo box in 
student-related atom screens and in the Mini Pic box in the Message 
Center whenever that student’s record displays.

1. Open the Student atom.

2. Locate the student’s record.

3. From the Student menu, select Attach Student Photo.

4. Select the student’s picture file from the appropriate directory. The 
image displays in the Crop/Zoom Image box.

5. Click the image and drag it to the appropriate position.

6. Adjust the magnification, if necessary.

7. Click OK. The image displays on the Student screen.

Changing Data in Name...ID Line

Unlocks the top line in each page of the Student screen so that you can 
make changes to data (Last Name, First Name, Middle Name, Grade, 
Gender, and Student ID). Changes display in all records for the student.

1. Open the Student atom.

2. Locate the student’s record.

3. From the Student menu, select Change Name...ID Line.

4. Click the field you want to change and enter new data.

5. Click Save.

Locating Students
School personnel frequently need to find student records to add, modify or 
delete information. There are several ways to find student records within 
the SASIxp™ software, depending on what record is needed.
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To find a student, use the Find function within any atom that contains a 
student record. If you want to add, modify or delete a student’s record, it is 
most efficient to perform the Find in the same atom as the record. For 
example, if you want to schedule a conference with a student, perform the 
Find in the Conference atom. If you want to record a disciplinary action for 
a student, perform the Find in the Discipline atom.

There are three ways to activate the Find function:

! From the Data menu, select Find Student.
! Press the Ctrl and F keys simultaneously.
! Click the magnifying glass on the atom screen.

You can make the search as broad or specific as needed, depending on 
what student information you know. To find a student, complete as much 
information as possible in these student fields:

! First Name
! Last Name
! Student ID Number
! Phone
! Address
! Parent or Guardian

Finding Students

1. Open an atom that contains student records. The system reads from 
the ASTU file.

2. From the Data menu, select Find Student.

3. Enter your search criteria in as many student information fields as you 
can. Entering more information narrows the search and fewer students 
display in the matrix.

4. From the matrix, double-click the line number (ln) corresponding to the 
student you want to find. The student’s information displays in the 
atom where you performed the Find function.

5. Modify or delete the student’s record as needed.

For example, entering A* in the Last Name field generates a matrix 
of all students whose last names begin with the letter A. Entering 
Anderson in the Last Name field generates a matrix of all students 
whose last name is Anderson.
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Locating Students on Campus

Sometimes, it’s necessary to locate a student within the school, for 
example, a parent arrives to pick up a student. Depending on the grade 
level of the student, the student’s location is stored in different atoms.

Locating an Elementary Student

1. Open the Student atom and display Page 1.

2. Find the student’s record. The room where the student is assigned is 
shown in the Room# field.

Locating Middle School or High School Students

1. Open the Classes atom.

2. Find the student’s record. The student’s entire class schedule, 
including room number, displays.
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Creating Parent or Guardian Profiles

The Parent Guardian atom (in the Student Info folder) enables you to 
create, maintain, and view address and employment information for the 
primary parent or guardian for a student and for any additional adults 
responsible for a student.

You can enter or update information in the Parent Guardian screen at any 
time, according to the needs of your school. See Data Menu Functions.

Entering or Modifying Parent Guardian Data
The Parent Guardian atom consists of two pages:

! Personal/Employment Page
! Using the Parent Guardian Atom

Personal/Employment Page

Use the Personal/Employment page to enter and view most information 
related to a student’s parents or guardians. This page accepts information 
about only one parent or guardian at a time.

You can add as many parent/guardian records as needed for each 
student. Add the parent or guardian who assumes primary responsibility 
for the student first, since that parent/guardian record displays first by 
default. Subsequent parents and guardians may be added for adults such 
as non-custodial parents or step-parents.

These data fields are required to enter parent or guardian data:

! Relationship
! Last Name
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! First Name

Personal/Employment Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.

You can change this data using one of two atoms within the SASIxp™ 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

Relationship
(REL table)

Identifies the relationship of the parent or 
guardian to the student.

Last Name Last name of the parent or guardian.

First Name First name of the parent or guardian.

Middle Name Middle name of the parent/guardian.

Title
(TTL table)

Title that the parent or guardian prefers on 
correspondence.
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Address Mailing address (street or P.O. box) for the 
parent or guardian. The system automatically 
enters student address information from the 
Student atom when you select a relationship. 
See Defining and Using Student 
Demographics. You can change this field if 
necessary.

City City portion of the parent/guardian mailing 
address. The system automatically enters 
student address information from the Student 
atom when you select a relationship. You can 
change this field if necessary.

St State portion the parent or guardian mailing 
address. The system automatically enters 
student address information from the Student 
atom when you select a relationship. You can 
change this field if necessary.

Zip Code Zip code portion of the parent or guardian 
mailing address. Enter a hyphen if you 
include the 4-digit extension. The system 
automatically enters student address 
information from the Student atom when you 
select a relationship. You can change this 
field if necessary.

Telephone Home phone number of the parent or 
guardian. The system automatically enters 
student address information from the Student 
atom when you select a relationship (but you 
can change it). The system automatically 
enters this number in the Phone Numbers 
atom. See Viewing Student Phone Numbers.

Alt Telephone Any alternate number such as a pager or 
cellular phone for the parent or guardian. The 
system automatically displays this number in 
the Phone Numbers atom.

Field Name Description
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Extn Extension for the alternate phone number. 
The system automatically displays the 
extension with the alternate phone number in 
Phone Numbers atom.

Soc Sec No. Social Security Number of the parent or 
guardian.

Birthplace Birthplace of the parent or guardian.

Employer Name of the company at which the parent or 
guardian is employed.

Occupation The occupation of the parent or guardian.

Work Address Address (street or PO Box) of the parent or 
guardian employer.

City City portion of an employer’s address.

St State portion of an employer’s address.

Zip Code Zip code portion of an employer’s address. 
Enter a hyphen if you include the four-digit 
extension.

Work Telephone Work phone number for the parent or 
guardian. The system automatically displays 
this number in the Phone Numbers atom.

Extn Any extension to be used with the work 
phone number. The system automatically 
displays this number in the Phone Numbers 
atom.

Work Hrs: From/To ! The From field indicates the hour that the 
parent or guardian typically arrives at 
work.

! The To field indicates the hour that the 
parent or guardian typically leaves work.

Enter the three digits for the time of day. The 
system inserts the colon and a.m. or p.m.

Field Name Description
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Using the Parent Guardian Atom

You can add as many parent/guardian records as needed for each 
student. The primary parent or guardian should be added first as they are 
the default when the record displays. Subsequent parents or guardians 
may be added and others such as non-custodial parents or step-parents.

Ctz Citizenship status of the parent or guardian. 
This field defaults to Y – US Citizen when you 
add a record.

E/M The extra mailings (E/M) field indicates 
whether school mailings should be sent to an 
additional parent or guardian. Select X for 
each additional parent or guardian (and leave 
the Rsp field blank in his or her record). This 
field enables you to print extra labels for that 
adult. An X in the Rsp field tells the system to 
print labels only for the primary parent or 
guardian.

Mil Indicates whether the parent or guardian’s 
military status entitles the school to special 
funding.

Cont Indicates whether the parent or guardian is 
allowed contact with a student.

Res Indicates whether a student resides with this 
parent or guardian. This field defaults to X-
Student Resides Here when you add a 
record.

Rsp Whether the parent or guardian has primary 
responsibility for the student. Select X in the 
record for the primary parent or guardian. 
This field tells the system to print mailing 
labels for the primary parent or guardian. 
Leave this field blank in records for additional 
parents or guardians.

Email Address Email address that can be used to contact 
the parent or guardian.

Field Name Description
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Adding the First Parent/Guardian Record

1. Open the Parent Guardian atom.

2. Locate the student record you want.

3. In the Relationship field, select the appropriate relationship to the 
student. (The system automatically enters address and phone number 
data from information in the Student atom. You can change this data.)

4. For all other fields on the Personal/Employment screen, type data or 
select items from the pop-up list.

5. Display the Comments screen to enter any additional information 
related to the parent/guardian.

6. Click Save to save the data in both forms.

Adding Additional Parent/Guardian Records

1. Open the Parent Guardian atom.

2. Locate the student record you want. (The system displays the first 
parent/guardian record entered for the student.)

3. From the Data menu, select Parent Guardian.

4. In the Relationship field, select the appropriate relationship to the 
student. The system enters address and phone number data from 
information in the Student atom, but you can change this data.

5. For all other fields on the Personal/Employment screen, type data or 
select items from the pop-up list.

6. Display the Comments screen to enter any additional information 
related to the parent/guardian.

7. Click Save.

Deleting Parent/Guardian Records

1. Open the Parent Guardian atom.

2. Locate the student record you want. 

3. Use the multi-record selection bar to display the parent/guardian 
record to be deleted.

4. From the Data menu, select Delete Parent Guardian.

5. Click Save to delete the parent guardian record from the database.
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Comments Screen

The Comments screen exists primarily so that you can record additional 
information about a student’s parent or guardian. You can note custody 
arrangements, special family situations, or instructions regarding to whom 
a student can be released on this screen. You can also use the Comments 
screen complete or modify field information. See Data Menu Functions.

Comments Fields

Field Name Description

Education Level
(EDU table)

Highest education level attained by the 
parent or guardian.

User Codes 1–5
(PG1-PG5 table)

Enables you to record any type of parent/
guardian data the school wants to track. The 
system displays up to five user codes.

Comments Large text field for entering additional parent/
guardian information. For example, you might 
note custody arrangements, special family 
situations, or instructions regarding to whom 
a student can or cannot be released.
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Multi-Record Selection Bar

The multi-record selection bar displays the number of parents or guardians 
assigned to each student. The bar displays on the right side of both the 
Personal/Employment and Comments screens in the Parent Guardian 
atom. It provides quick access to all the parent/guardian records for a 
student.

Numbers for each parent/guardian are assigned in the order that the 
parents and guardians are added for the student. Use the arrows to move 
through the parent/guardian records in consecutive order.

Parent/Guardian Menu Report

Report Description

Parent Labels
(PRN01)

The parent/guardian labels display parent/
guardian name, student name, and home 
address including city, state, and zip code. 
Run these labels for the Extra Mailings Only 
or for the Responsible Party Only.
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Defining Emergency Records

The Emergency atom (in the Health/Emergency folder) enables you to 
create, maintain, and view emergency records for a student. A student 
emergency record contains all the medical alert and contact information 
necessary to contact a student’s parent or guardian in case of a medical 
emergency.

Working with Emergency Records
Add, update, and delete a student's emergency record in all three tabs of 
the Emergency atom. See Data Menu Functions.

! Emergency Contacts Tab
! Other Contacts Tab
! Emergency Information Tab

Emergency Contacts Tab

Use the Emrg Contacts Tab to enter and view information about a 
student’s primary and secondary emergency contacts.
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Emergency Contacts Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.

You can change this data using one of two atoms within the SASIxp™ 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

First Contact Name of the first person to contact in an 
emergency, normally the student’s parent or 
guardian.

Telephone Phone number of the primary emergency 
contact. The system automatically displays 
this number in the Phone Numbers atom.

Extn The extension, if any, to the phone number of 
the primary contact.

Relationship
(EMR table)

Primary contact’s relationship to the student.

Address Street address or PO Box portion of primary 
contact’s address.

City City portion of primary contact’s address.

St State portion of primary contact’s address.

Zip Code Zip code portion of primary contact’s 
address. Type a hyphen if you include the 
four-digit extension.

Secondary Contact Name of person to contact if primary contact 
cannot be reached.

Telephone Phone number of the secondary emergency 
contact. The system automatically displays 
this number in the Phone Numbers atom.

Extn Any extension to the phone number of the 
secondary contact.
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Other Contacts Tab

Use the Other Contacts tab to list other persons to notify if the first and 
second contact is unavailable in an emergency.

Relationship
(EMR table)

Secondary contact’s relationship to the 
student.

Address Street address or PO Box portion of 
secondary contact’s address.

City City portion of secondary contact’s address.

St State portion of secondary contact’s address.

Zip Code Zip code portion of secondary contact’s 
address. Type a hyphen if you include the 
four-digit extension.

Field Name Description
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Other Contacts Fields

Field Name Description

Third Contact Name of the third emergency contact.

Telephone Phone number of the third emergency 
contact.

Extn The extension, if any, to the phone number of 
the third contact.

Relationship The third contact’s relationship to the student, 
which you select from a drop-down list - EMR 
table.

Address Street address or PO Box portion of the third 
contact’s address.

City City portion of third contact’s address.

St State portion of third contact’s address.

Zip Code Zip code portion of third contact’s address.

Fourth Contact Name of fourth emergency contact.

Telephone Phone number of the fourth emergency 
contact.

Extn Any extension to the phone number of the 
fourth contact.

Relationship Fourth contact’s relationship to the student - 
EMR table.

Address Street address or PO Box portion of the 
fourth contact’s address.

City City portion of the fourth contact’s address.

St State portion of the fourth contact’s address.

Zip Code Zip code portion of the fourth contact’s 
address.
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Emergency Information Tab

Use the Emrg Info tab to record information about a student’s medical 
conditions and physician.

The large Comment field under the physician information accepts up to 
32,000 characters. Use the Comment field to explain medical conditions, 
note medications taken by a student, or record medical equipment 
required for a medical condition.
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Emergency Information Fields

Using the Emergency Atom

Adding Emergency Records

1. Open the Emergency atom and display the Emergency Contacts 
screen (from the Emrg Contacts tab).

2. Locate the student record you want.

3. For all fields, type data or select an item from the pop-up list.

4. Display the Other Contacts screen.

5. For all fields, type data or select an item from the pop-up list.

6. Display the Emergency Information screen.

7. For all fields, type data or select an item from the pop-up list.

8. Click Save.

Field Name Description

Medical Alert 1 Primary medical condition that might affect a 
student, such as diabetes or asthma.

Medical Alert 2 Secondary medical condition that might affect 
a student, such as allergies.

Physician Name of the doctor to contact in case of an 
emergency.

Telephone Phone number of the doctor to contact in an 
emergency. The system automatically 
displays this number in the Phone Numbers 
atom.

Extn Extension to the doctor’s phone number.

Comments Text area. Everyone with access to the 
Emergency atom can read these comments.
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Deleting Emergency Records

1. Open the Emergency atom.

2. Locate the student that you want.

3. From the Data menu, select the Delete Emergency option. The system 
displays a dialog box.

4. Click OK to confirm deletion of the student emergency record.

Emergency Menu Report

Report Name Description

Student Contact Form
(EMG01)

Prints a form with student emergency and 
health information. This form is sent home 
with children so that parents or guardians can 
verify the school’s data on file. The form 
contains a signature line for each parent or 
guardian included on the form.
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Viewing Student Phone Numbers

The Phone Numbers atom (in the Student Info folder) enables you to 
locate student telephone numbers quickly. This is a view-only atom. It 
displays all phone numbers, including parent/guardian numbers and 
emergency contacts, that are available for a student.

Viewing the Phone Numbers Screen
You must display a student record in another atom before the Phone 
Numbers screen displays any data (it remains blank). If you have multiple 
student records open in other atoms then open the phone numbers atom, 
the screen displays the numbers for the most recently active student 
record—the one in which you were just working. If you leave the Phone 
Numbers atom open while working in other atoms, the Phone Numbers 
screen displays the numbers for the record in the active atom.

Phone Numbers Screen
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Phone Numbers Fields

Changing a Phone Number’s Original Record

1. Open the Phone Numbers atom.

2. Double-click any field within a row. The system opens the atom in 
which the phone number is stored (for example, the Parent/Guardian 
atom).

3. Edit the phone number information in the atom where it is stored.

4. Click Save.

5. Click Close. The system returns you to the Phone Numbers screen, 
which displays the new phone number information.

Field Name Description

Line Line number for each phone number.

Relationship Relationship between the student and the 
individual whom the phone number contacts. 
Also identifies the atom in which each phone 
number is stored (STU for Student, PRN for 
Parent Guardian, EMG for Emergency).

Name Name of the individual to whom the phone 
number belongs.

Phone Each phone number (including area codes if 
entered in other atoms).

Ext. Any extension available for a phone number.

If the change you’re making is to the Student file and a match exists 
in the Parent/Guardian file, a message displays prompting you to 
update those records as well. Click Yes to update the records.
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Using the Student Data Utility

The Student Data Entry atom (in the Student Info folder) is a tool that 
enables you to add student information into the system using one atom 
instead of multiple atoms. Unlike all other atoms, which record unique 
information, the Student Data Entry atom serves as a tool for collecting 
information that is recorded in various files.

Entering or Modifying Student Data
The Student Data Entry atom contains multiple data entry screens with 
various fields for student data input. Settings in the Student Data Entry 
Definition atom determine the fields that display in the Student Data Entry 
atom and how they are arranged.

A student must be enrolled using the Enrollment atom before you can use 
the Student Data Entry atom to record new, or change existing, student 
information. When you locate a student record in the Student Data Entry 
atom, any existing student information displays in the fields.

Changes to existing information performed in this atom are recorded 
permanently in the system.
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Student Data Entry Screen

The Student Data Entry screen varies depending on the fields set up by 
your system administrator in the Data Entry Definition atom. This is one 
example of a data entry screen:
110  Entering or Modifying Student Data Copyright © 2000–2004 Pearson Digital Learning



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Student Data Entry Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.

You can change this data using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Entering Data in the Student Data Entry Screen

These instructions indicate how to use the Student Data Entry atom to 
enter student data, which is recorded in multiple student information files.

1. Open the Student Data Entry atom.

2. Locate the student’s record.

3. Locate the appropriate fields for data entry and enter data.

4. Click Save.

Field Name Description

Line Line number for each row.

Field Name Field name from the Data Entry Definition file 
or the label (if you entered one).

Data Displays information you recorded previously 
in this field. You can replace existing 
information.

If you are adding information to the parent/guardian file and have not 
entered a first or last name for the parent, the record is not added, 
and an error message displays.
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Establishing Sibling Records

Use the Sibling atom (in the Student Info folder) as a tool to save data 
entry time when a new student has a sibling who is already enrolled at 
your school. This atom reviews information available for one sibling from 
the Student, Parent/Guardian, and Emergency atoms. Then it duplicates 
that data in records for the newly enrolled sibling.

Only data that could be common to both students is copied to the new 
sibling’s record. Unique data (such as birth date and Social Security 
Number) is left blank for you to complete.

The system establishes a unique Family ID the first time that you use the 
Sibling atom for related students. The unique family number also applies 
to future siblings who enroll if you use the Sibling atom.

Sibling Screen

The Sibling screen enables you to search for existing sibling data, then 
copy that data to the records for the new sibling.
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Sibling Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID. You can change this information using one of two 
atoms within the SASIxp software. See Defining and Using Student 
Demographics. See Enrolling Students. On this screen the header fields 
are read-only.

Field Name Description

Sibling Search 
Information

Search fields for information about a 
previously enrolled sibling. The system 
copies information from these fields to the 
record of the new sibling. Fields include: Last 
Name, First Name, Middle Name, Grade, 
Gender, Student ID, and all Address fields. 
The Track field also displays for track 
schools.

To narrow the search, complete additional 
fields.

Student ID Identification numbers assigned to each 
student located by the search.

Student Name Complete name of each student located by 
the search.

Parent/Guardian Parent or guardian name of each student 
located by the search.

Fam# Family number assigned to each student.

Phone# Phone number of each student located by the 
search.
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Copying Sibling Data

You must enroll a new sibling student before you can use the Sibling atom 
to copy sibling data. Remember to use the Student and Emergency atoms 
to enter data that is unique to a newly enrolled sibling after you have 
copied common data using the Sibling atom.

1. Open the Sibling atom.

2. Find the student’s record. The header displays the student’s data from 
the Enrollment atom, and the new student’s last name displays in the 
Last Name field in the Sibling Search Information section.

3. Search for the student’s siblings using the fields in the Sibling Search 
Information section. Type data or select an item from the pop-up list in 
each field you want to use as search criteria.

To clear all information in fields within the Sibling Search Information 
section, select Clear Sibling Search Info from the Sibling menu.

4. Click Locate to display students who match the selected criteria.

5. Click the Student ID to highlight the row of information to copy. The 
Copy Sibling Info button becomes active.

6. Click Copy Sibling Info to copy the highlighted row of data into the 
record of the student who displays on the header of the Sibling screen. 
If a confirmation message displays, click OK to proceed.

Find/Locate Button Find enables you to locate the new sibling 
whose records require information.

When the new sibling record displays, the 
Find button becomes the Locate button.

Locate enables you to search for the sibling 
who is already enrolled and has records at 
your school. The system displays all students 
who match the criteria that you enter in the 
Sibling Search Information fields.

Copy Sibling Info Button Copies Student, Parent/Guardian, and 
Emergency data from the existing sibling 
records to new sibling record. The button 
becomes available when you select a student 
from the matrix of students who match your 
search criteria.

Field Name Description
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7. Click OK to clear the system message indicating that data was copied 
successfully.

8. Click Close to exit from the Sibling atom.

9. Open the Student and Emergency atoms to enter data that is unique to 
the newly enrolled sibling.

Sibling Menu Option

Clear Sibling Search Information

Clears all fields in the Sibling Search Information section. By default, the 
system enters the last name of the student on the top line of the Sibling 
screen in the Last Name field.
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Entering and Maintaining Health Records

The Health atom (in the Health/Emergency folder) enables you to create, 
maintain, and view health records for a student. A student’s health record 
contains data on visits to the school nurse and other health-related 
incidents that occur at school or affect a student’s attendance or 
performance at school. The health record also contains a record of 
required immunizations and vaccination dates for each student.

Health Record Tabs
The Health atom consists of five tabs:

! Health History Tab
! Immunizations Tab
! Medical Tab
! Health Screening Tab
! Scoliosis Screening Tab

Caution

Deleting health records permanently removes them from the system. You 
cannot restore deleted records; you must recreate them.

Health History Tab

The Health History tab displays a row for each health-related incident that 
occurs at school or that affects a student’s attendance or school 
performance.
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Use this tab to add, update or delete a student’s health incident record. 
See Data Menu Functions. You do not need to complete a record in the 
Health History tab unless a student experiences a health incident.

Health History Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.

You can change this data using one of two atoms within the SASIxp™ 
educational software. See Defining and Using Student Demographics. See 
Enrolling Students. On this screen the header fields are read-only.

Field Name Description

Ln Displays the line number for each incident. 
Double-click a line number to display the 
detail screen for an incident.

H Code
(HLD table)

Pop-up list of school-defined health codes for 
each incident.
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Health History Detail Screen

The Health History Detail screen displays data related to a single health 
incident. The fields in this screen correspond to columns in the Health 
History tab. The screen also includes a Comments field for additional 

Comment Description of the 3-letter code. Although 
comments display automatically when you 
select a code, you can change them 
according to your needs. For example, if you 
select the code BRK and the comment 
“broken bone” displays, you can change it to 
“broken finger.”

Eff. Date Displays the date each health incident began. 
This field automatically defaults to the current 
date (but you can change it). 

End Date Displays the date each health incident ended. 
For some health incidents (such as allergies) 
there may not be an end date.

V Code
(VST table)

Displays the code that describes the type of 
visit that was made.

Visitation Comment Description of the visitation code. This field 
displays automatically but you can change it 
or add to it.

Fol Date (Follow up 
date)

Displays the date when the student should be 
checked again.

Time In Displays the time the incident occurred. Enter 
four digits, and the system enters the colon 
and a.m. or p.m.

Time Out Displays the time the incident ended. Enter 
four digits, and the system enters the colon 
and a.m. or p.m.

User 1–4 User-defined health codes.

Field Name Description
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incident information. You can access a detail screen by double-clicking the 
line number of any record in the Health History tab. Use this screen to add 
or update a student’s health history record. See Data Menu Functions.

Health History Detail Field

Immunizations Tab

The Immunizations tab displays data related to separate immunization 
records. It includes a row for each immunization required for a particular 
student. The tab allows a maximum of 10 required dosages for any 
immunization type.

When a dosage date cell is shaded, a dosage is not required. The number 
of unshaded date cells in a vaccination row indicates the number of 
required dosages. Immunization requirements are defined in the Vaccine 
Definition atom.

Field Name Description

Comments A large text field for typing additional 
information related to a specific health 
incident. The field accepts over 32,000 
characters. A scroll bar displays on the right 
side when the field becomes full.
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Enter data in the Immunizations tab for all students so that your school 
maintains a record of required vaccination information. Use this tab to add, 
delete, or update a student’s immunization record. See Data Menu 
Functions.

Immunizations Fields

Field Name Description

Ln Displays the line number for each vaccination 
row. Double-click a line number to display the 
detail screen for a vaccination.

Vaccination Displays the name of each required 
vaccination. These names are automatically 
entered from the Vaccine Definition atom.

Compliant
(CMP table)

Indicates whether the student is in 
compliance with the indicated immunization.

Exempt
(EXE table)

Displays an exempt code letter if the student 
is exempt from vaccination. (Exempt students 
may display as non-compliant for the 
immunization.)
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Immunization Detail Screen

The Immunization Detail screen displays the data related to a single 
immunization record. The fields in this screen correspond to columns in 
the Immunizations tab. The detail screen also includes a Comments field 
for additional immunization information.

You can access an immunization detail screen by double-clicking the line 
number of any record in the Immunizations tab. Use this screen to add or 
update a student’s immunization record. See Data Menu Functions.

1st Date Displays the date the first required dosage 
was administered.

2nd Date – 10th Date These columns contain the dates that 
additional dosages were administered. In 
columns where a dosage is required for a 
vaccination, the cells are unshaded and 
unlocked. In columns beyond the last dosage 
required, the cells are shaded and locked.

Field Name Description
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Immunization Detail Field

Medical Tab

The Medical tab enables you to record information about tuberculosis skin 
tests and chest x-rays. Use this tab to add or update a student’s Tuberculin 
skin test record. See Data Menu Functions.

Medical Tab Fields

Field Name Description

Comment A field for additional comments about a 
particular immunization.

Field Name Description

Date Given Date of skin test.

mm indur Size of induration in millimeters.
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Health Screening Tab

The Health Screening tab enables you to record information about 
screenings and referrals for vision and hearing. It also enables you to 
record height and weight information. Use this tab to add or update a 
student’s health screening record. See Data Menu Functions.

Impression Indicates whether skin test was positive, 
negative, or not taken. If marked positive, the 
Tuberculosis Chest X-Ray section displays.

Film Date Date of chest x-ray.

Impression Indicates whether chest x-ray was normal or 
abnormal.

Field Name Description
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Health Screening Tab Fields

Field Name Description

Ln Displays the line number for each screening 
record. Double-click a line number to display 
the detail screen for a screening.

Date The date the screening was performed. The 
default is the current date, but you can 
change the date.

Grade Student’s grade at time of screening.

Vision

Color
(EYE table)

Displays color blindness reading.

R Eye
(VTR table)

Select screening results from the pop-up list. 
The code letter for the results displays in this 
field.

L Eye
(VTR table)

Select screening results from the pop-up list. 
The code letter for the results displays in this 
field.

Referral
(RCT table)

Identifies action taken based on screening 
results.

Date Date the referral was acted upon.

Aid
(VHA table)

Select a corrective aid (such as glasses) from 
the pop-up list. Leave blank if no aid was 
prescribed.
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Health Screening Detail Screen

The Health Screening Detail screen displays the data related to a single 
screening record. Most fields in this screen correspond to columns in the 
Health Screening tab. You can access a health screening detail screen by 
double-clicking the line number of any record in the Health Screening tab. 
Use this screen to add or update a student’s health screening record. See 
Data Menu Functions.

Hearing

R Ear

(HTR table)

Select screening results from the pop-up list. 
The code letter for the results displays in this 
field.

L Ear
(HTR table)

Select screening results from the pop-up list. 
The code letter for the results displays in this 
field.

Referral
(RCT table)

Identifies action taken based on screening 
results.

Date Date the referral was acted upon.

Aid
(VHA table)

Select a corrective aid (such as hearing aid) 
from the pop-up list. Leave blank if no aid 
was prescribed.

Height

Height Student’s height in inches and hundredths 
(for example, 66.25).

Pct Percentile ranking of this student’s height 
measurement based on averages for age 
and gender.

Weight

Weight Student’s weight in pounds.

Pct Percentile ranking of this student’s weight 
measurement based on averages for age 
and gender.

Field Name Description
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Use the Health Screenings Detail screen to record information about 
specific screenings. This data include details related to vision, hearing, 
height, and weight.

Health Screening Detail Fields

These fields display only on the Health Screening Detail screen.

Field Name Description

Vision

Test Late If the test was performed late, select Yes 
from the pop-up list. If the test was not late, 
leave this field blank.

Hearing

Test Late If the test was performed late, select Yes 
from the pop-up list. If the test was not late, 
leave this field blank.

Impaired Hearing Test If the student was given an impaired hearing 
test, select Yes from the pop-up list. If no 
impaired hearing test was given, leave the 
field blank.
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Scoliosis Screening Tab

This tab enables you to record information about screenings and referrals 
for scoliosis. Use this tab to add or update a student’s scoliosis screening 
record. See Data Menu Functions.

Scoliosis Screening Fields

Result
(HTR table)

If an impaired hearing test was administered, 
select a result from the pop-up list.

Comments You can use this area to enter notes about 
this specific health screening.

Field Name Description

Field Name Description

Film Date Date the scoliosis X-ray was taken.

Impression Results of the scoliosis X-ray. Select Normal, 
Abnormal, or No X-ray.
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Adding Scoliosis Records

1. Open the Health atom, and find the appropriate student record.

2. Select the Scoliosis Screening tab.

3. In the Film Date field, enter the date of the first scoliosis X-ray.

4. Select the results of the X-ray.

5. In the Exam Date field, enter the date the scoliosis physical exam was 
given.

6. Select the results of the physical exam.

7. Click Save, or click Undo to undo all changes on this page.

8. Click Close.

Entering Data in Health History Screen

You do not need to complete a record in the Health History matrix unless a 
student experiences a health incident.

Adding Health Incidents

1. Open the Health atom and display the Health History form.

2. Locate the student record that you want.

3. From the Data menu, select the Add Health option. The system adds a 
new incident row and enters the current date in the Eff. Date field (you 
can change this date).

4. From the H Code column cell in the incident row, select a health code 
from the pop-up list. The code description displays in the Comments 
field (you can change the description).

5. In the End Date column, type the end date for the health incident. This 
field can be completed later if you don’t know the date.

Exam Date Date the scoliosis physical exam was 
performed.

Exam Result Results of the scoliosis physical exam. Select 
Failed, Passed, or No Exam.

Field Name Description
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6. From the V Code column cell in the incident row, select a visitation 
code from the pop-up list. The description for the code displays in the 
Comment field (you can change this description).

7. In the Fol. Date field, type a follow-up date if applicable.

8. Click Save.

Adding Health Incident Comments

1. Open the Health atom and display the Health History form.

2. Locate the student record that you want.

3. Double-click the line number (Ln) for the incident. The incident must 
already have been saved in the system. The Health History Detail 
screen displays.

4. In the Comments field, enter any notes related to the specific health 
incident.

5. Click Save.

Entering Data in Immunizations Screen

Entering Vaccination Dates

1. Open the Health atom and display the Immunizations screen.

2. Locate the student record that you want.

3. Type known vaccination dates into unshaded cells within the matrix. 
Shaded cells mean dosages are not required.

4. Click Save. If you need to enter a comment, follow Steps 5 -8.

5. Double-click the line number (Ln) for the incident. The incident must be 
in the system. The Immunization Detail screen displays.

6. In the Comments field, enter any notes (up to 15 characters) related to 
the student’s immunization record.

You can enter comments for multiple health incidents associated 
with one student prior to saving all new incident comments. Use the 
multi-record selection bar to display various incident forms, enter 
comments in each of them, then click Save to save comments in all 
of the student’s health incident records.
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7. Click Save to save the new data.

8. Click Close to return to the Immunization screen.

Adding Exemption Codes for Immunizations

1. Open the Health atom and display the Medical tab.

2. Locate the student record that you want.

3. In the Exempt field for the particular immunization, select an item from 
the pop-up list.

4. Click Save.

Updating Compliance Fields for Students

1. Open the Health atom.

2. From the Health menu, select the Update Compliance Fields option.

The system examines all vaccination dates for all students and 
updates the compliance fields.

Entering Data in Medical Screen

Adding Tuberculin (TB) Skin Test Records

1. Open the Health atom and display the Medical tab.

2. Locate the student record that you want.

3. In the first Date Given field, type the date of the first TB test.

4. In the first mm Indur field, type the size of the swelling in millimeters.

5. In the first set of Impression field options, select Positive, Negative or 
Not Tested.

! Not Tested or a Negative result requires no additional data input. 
Click Save.

! A Positive result requires additional input. The system displays the 
Chest x-ray window.

6. For the chest X-ray results, click Normal or Abnormal.

7. Click Save.

8. Click Close.
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Entering Health Screening Information

Use the Health Screenings Detail screen to record information about 
specific screenings. This information include details related to vision, 
hearing, height, and weight.

1. Open the Health atom and display the Health Screenings screen.

2. Locate the student record that you want.

3. From the Data menu, select the Add Screening option. The system 
adds a new incident row and enters the current date in the Date field. 
You can change this date.

4. Enter health screening data directly into the Health Screening screen 
or display the Health Screening Details screen to enter a health 
screening record. For all health screening fields, type data or select an 
item from the pop-up list.

5. Click Save.

Health Menu Options

Vaccine Definitions

Activate the Vaccine Definition atom to view or edit the core list of 
immunizations used in the Immunizations screen. Typically, the list 
consists of immunizations required by the state. You can add a non-
required immunization such as Tetanus shots.

Update Compliance

When running this program, the system examines the dates for all 
immunizations for each student. It performs updates accordingly. If no 
immunization records were added for a student, updating compliance adds 
AIMM records to display as N (not compliant) in the Compliance field.
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Health Menu Reports

Report Name Description

Immunization Record
(IMM01)

Produces a report displaying student 
immunization records with the dates of each 
vaccination. You can use preprinted IMM 
forms with this option.

Health Code Count
(IMM02)

Lists the health code and the total instances 
of that code for a selected group of students 
or for all students.

Immunization Count
(IMM03)

Lists the total number of students that have 
taken each vaccination defined in your 
system.

Immunization 
Compliance
(IMM04)

Status of student’s compliance with required 
vaccinations.

Immunization Summary 
(IMM05)

Displays individual student immunization 
records with dates of each vaccination. 
Similar to IMM01, except you can print on 
plain-paper rather than preprinted IMM forms.
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Creating Matrixes

A matrix displays when you use the Find function to search for multiple 
records that match criteria you specify. Below each matrix, the system 
displays the number of records in the list. Scroll bars enable you to view 
data beyond what displays on the screen. The matrix for each atom 
contains its own set of rows and columns that display atom data.

Working with Results from Multiple Records
From a matrix with multiple records that results from a Find, you can:

! View the list of records that matches specified search criteria.
! Print the entire matrix or selected rows and columns.
! Display individual records in the currently active screen.
! Export matrix data to a file to use with other applications.
! Display matrix data in graph form.
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Matrix Rows

Each matrix displays a record found during a search. Each row can be 
labeled as Student ID, User ID, Course ID, or Section ID depending on the 
type of atom from which you performed the Query.

Matrix Columns

The standard matrixes contain these columns:

! Columns for student data are labeled Student ID, Sta (status), Last 
Name, First Name, Middle (initial), GNRTN (generation), Grd (grade), 
Gen (gender), and Birthdate.

! Columns for user data are labeled User ID, User Name, Year, School, 
User Class, and Discipline Security Level (DSL).

! Columns for course data are Course ID, Title, Low, High, Du 
(Duration), Dept, Alternate ID 1, and State ID 1.

! Columns for section data are Section ID, Course, Period, Sem 
(Semester), Course Title, Tch #, Teacher Name, and Seats (# available 
for each section).

Columns for other fields display in matrixes if you specify search criteria in 
those fields. For example, if you perform a Find on the Ethnic Code field, 
the resulting matrix contains the Student ID, Status, Last Name, First 
Name, Middle Initial, Grade, Gender, Birthdate, and Ethnic Code fields.

Resizing Matrixes

You can resize matrixes or screens that display as, or contain, matrixes. 
Widening a matrix enables you to display all or most columns without 
resizing the columns or using the horizontal scroll bar.

Click and hold the Resize button that displays in the lower right corner of 
matrix (under or next to a scroll bar) then drag the mouse in the direction 
that you want to enlarge or shrink the matrix:

! Drag right to widen a matrix.
! Drag left to reduce matrix width.
! Drag down to elongate a matrix.
! Drag up to shorten a matrix.
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Creating Matrixes within Student

1. Open the Student Atom.

2. Click the magnifying glass to get in the Find Mode OR Control F.

3. Enter an asterisk (Shift + 8) in any of the fields on the Student Form 
OR a letter.

4. Click the Find Button OR press the enter key.

Finding Multiple Records that Display Matrixes

1. Display any atom screen.

2. Determine the fields on which you want to perform a Find, then enter 
search criteria into the fields:

3. Select a value from the pop-up list if one is available.

4. Click Find or press Enter for the system to begin searching for records 
that match your specified criteria. A progress bar displays in left 
Message Center. When the search is complete, the system displays a 
matrix listing all records matching your criteria.

Search Criteria Description

Letter * One letter followed by an asterisk produces a 
matrix listing all records that begin with the 
letter (wildcard search).

Partial Information * One or more letters or numbers followed by 
an asterisk produces a matrix listing all 
records that begin with the specified letters or 
numbers.

Letter or Partial 
Information > or < or :

One or more letters (or numbers) followed by 
one of these signs produces a matrix listing 
all records that are greater than, less than, or 
contain the specified criteria, respectively.

* An asterisk produces a matrix listing all 
available records from the selected atom.
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Finding Specific Records in Matrixes

Use the scroll bar arrows or the scroll button on the right side of the matrix 
to display matrix records.

Displaying One Record from the Matrix

Double-click the ID column (or click the ID column then click Open). The 
system displays the record in the screen.

Displaying Multiple Records from the Matrix

1. Hold down the Shift key and click the ID for each record that you want. 
Ensure that each row becomes highlighted.

2. Double-click the ID in any highlighted ID field or just click Open. The 
selected records display in separate atom forms in reverse alphabetic 
or numeric order. Click anywhere in an open screen to move it to the 
foreground and designate it as the active screen.

Deselecting Highlighted Rows and Columns

Click the Student ID column heading in the matrix to remove highlighting 
from all previously selected rows and columns.

Closing Single Screens Opened from a Matrix

Click Close in the atom screen for each open record. You can also click the 
Close box (Macintosh), click the X (Windows 95), or double-click the 
Control-menu box (Windows) in the upper right corner of the title bar. If you 
typed data into the form, click Save or Undo prior to closing. You can still 
see the matrix.

Closing Screens Opened from Matrixes

To close all open forms at once (including the matrix), hold down the 
Option key and click the Close box (Macintosh), hold down the Alt key and 
double-click the Control-menu box (Windows). You can also hold down the 
Alt key and click the X (Windows 95) in the title bar of the active window.
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Sorting Records in Matrixes

Sort records in a matrix by ascending and descending order in one column 
or multiple columns. Double-click a column heading to sort records in a 
matrix. You also can click a column heading then go to the Data menu and 
select the Sort List option. Records sort in ascending order:

! If you sort by Last Name, the matrix list displays records in alphabetical 
order by last name.

! If you sort by Grade, the matrix list displays records from the lowest to 
the highest grade. Students display alphabetically by last name within 
each grade.

! If you sort by Gender, the matrix list displays records first by females 
then by males. Students display alphabetically by last name within 
each gender.

Sorting Matrixes in Reverse Order

Hold down the Option key (Macintosh) or the Alt key (Windows) and 
double-click a column heading or double-click the right mouse button 
(Windows). Records sort in descending order:

! If you reverse sort by Last Name, the matrix list displays records in 
reverse alphabetical (from Z to A) order by last name.

! If you reverse sort by Grade, the matrix list displays records from the 
highest to the lowest grade. Students display in reverse alphabetical 
order by last name within each grade.

Performing Multi-Level Sorts

1. Hold down the Shift key and click each column heading in the order in 
which you want to sort.

2. From the Data menu, select the Sort List option or double-click the last 
column selected. The matrix list displays records sorted in ascending 
order by each column in the order you selected them.

! If you sort first by Last Name then by Gender, the matrix list 
displays records in ascending alphabetical order by last name. 
Within each letter of the alphabet, all female students display prior 
to male students, for example, Jennifer Brown displays before 
Christopher Brown.

! If you sort first by Gender then by Last Name, the matrix list 
displays all females prior to males. Within each gender, students 
display in ascending alphabetical order by last name.
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Graphing Matrixes

Use the Graph option on the Data matrix to display matrix data in graphical 
format. You can then select from options for displaying the graphed data.
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Graph Window Options

Option Description

Bar Graph Displays matrix values in terms of bars. The 
horizontal graph axis reflects values from the 
first column selected. Bars reflect values from 
the second column selected. You can click 
any bar to display coordinate values at that 
point. The first coordinate is for the value on 
the horizontal axis while the second 
coordinate is value for the bar at the first 
coordinate. It displays the total value 
represented by bars with the same color.

Line Graph Displays matrix values in terms of lines. The 
horizontal graph axis reflects values for the 
first column selected. Lines reflect values 
from the second column selected. Each line 
is color coded to distinguish it from other 
lines. You can click anywhere on a line to 
display what that line represents. You can 
also check the legend in the upper right 
corner of the Graph window.

Line-Box Graph Displays matrix values in lines with small 
boxes. The horizontal axis reflects values for 
the first column selected. Lines reflect values 
from the second column selected. The color-
coded boxes on each line enable you to 
display the values at graph coordinates. 
Simply click a box to display coordinate 
values at that point. The first coordinate is for 
the value on the horizontal axis while the 
second coordinate displays the value on the 
line at the first coordinate. It also displays the 
total value represented by the line.
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Graphing Matrixes

1. Hold down the Shift key and click two column headings.

2. From the Data menu, select the Graph option. The Graph window 
displays with the matrix in bar graph format and the names of the two 
selected columns in the title bar.

3. In the Graph Type selection area, click the check box next to any other 
type of graph you want displayed.

4. Clear the Show Legends check box if you do not want to display the 
Legend or select the On Graph check box to position the legend 
directly over the graph.

5. Select the Auto Scale check box to automatically scale the graph.

Pie Chart Displays values from each column in a pie 
chart. Each value is color-coded. If you 
selected a Grade column from a matrix, the 
pie chart displays a slice for each grade level. 
Click any slice to display the value for that 
slice. Using the Grade example again, the 
first value is for the grade level represented 
by the slice; the second value is for the 
number of students at that grade level; and 
the third value is for the total number of 
students represented in the matrix. The pie 
chart option is only available if one column 
has been selected in the matrix.

Show Legends Enables you to display or remove a legend 
indicating what each color code represents in 
a graph. Select this option (the default 
setting) to display the legend in the upper 
right corner of the Graph window. Clear the 
check box to remove the legend.

On Graph Enables you to display a legend directly over 
a graph instead of to the right of the graph. 
Click the check box to expand the graph until 
the right side is positioned under the legend.

Auto Scale Enables you to scale a graph automatically.

Option Description
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6. From the File menu, select Print if you want to print the graph.

7. Click Close to exit from the Graph window.

Exporting Matrixes

Use the Export List option on the Data menu to export matrix data into a 
file that can be used by another application, such as word processing or 
spreadsheet application.

You can export matrix data from matrix regardless of whether the matrix 
was produced by a Find or query or is part of an atom form. You must 
display the matrix before you export its data.

The file format used for exported SASIxp™ lists is compatible with a 
variety of other applications. When you open an exported matrix in a word 
processing application, it displays the same rows and columns as the 
matrix in the SASIxp software.

Exporting Lists

1. Display a matrix.

2. From the Data menu, select the Export List option. The system 
displays a Save dialog box.

3. In the Export file name field, type the name of the file. Also, type the 
name of the folder or directory where the file should be stored if the 
one displayed is not correct.

4. Click Save to export and save the data into the specified location. You 
can now open file in another application.

Creating Data Atoms for Lists

These instructions indicate how to create a user-generated data atom for a 
list of records.

1. Open any atom.

2. Perform a Find using criteria that results in a matrix of the student 
records that you want.

3. Hold down the Shift key and click the ID of each student that you want 
to include in the Data atom. Ensure that the row for each student you 
want is highlighted.
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4. Click and hold any cell in the matrix. A dotted line displays around the 
selected cell.

5. When you see the dotted line around the selected cell, drag the dotted 
outline into the workspace and drop it. When you drop the field, the 
system displays the same SASIxp atom icon where the original data is 
stored except that an orange data atom symbol indicates that the new 
atom is a user-generated Data atom. A word list also displays 
underneath along with the name of the first student in the list. This 
Data atom contains the list of all students that you selected from the 
matrix.

6. To assign another name to the atom, click the new Data atom, then go 
to the File menu and select the Atom Info option. From this option, you 
can give the atom a different name, enter a description, assign a Hot 
Key, or lock the atom. Ensure that all screens are closed to avoid 
accidentally changing the active window.

Matrix Exercise

1. Open the Student Info folder.

2. Open the Student atom.

3. Use the first letter of your last name followed by an asterisk (*) to 
create a matrix of all the students whose last name begins with that 
letter.

4. Sort the matrix by gender.

5. Perform a multiple record sort first by gender first then by grade.

6. Create a graph by selecting the Gender column then the Grade 
column.

7. Close the graph, then close the matrix.

8. Click the magnifying glass on the Student atom screen.

9. In the Grade field, select any grade from the pop-up list and create a 
matrix for student in the selected grade.

10. Perform a reverse sort by first name.

11. Display the Student screen for any three students in the matrix.

12. Close one Student screen.

13. Close the remaining screens at one time.
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Entering Discipline Incidents

The Discipline folder contains two atoms for documenting and tracking 
discipline incidents. 

! Use the Discipline atom to create, maintain, and view student 
discipline records. These records contain information about 
disciplinary infractions that students commit at school. 

! Use the Discipline Codes atom to define disciplinary infractions. 

This chapter explains how to use the Discipline and Discipline Codes 
atoms.

Working with Discipline Incidents
Add, modify, or delete discipline information for students at your school 
using the Discipline atom. See Data Menu Functions. For more detail, see 
also Using the Discipline Screens.

Caution

Deleting a discipline record permanently removes it from the system. You 
cannot restore deleted records; you must re-create them. 

Before beginning this process, use the Backup/Restore atom in the File 
Management folder to back up your discipline records.

Discipline Menu Options

The Discipline pop-up menu lists options to access Discipline Codes, 
create the Disposition Table, and print discipline reports.

Discipline Codes

This option opens the Discipline Codes atom so you can view or change 
the list of school-defined discipline codes used in the Discipline matrix. 

To add or delete codes, see Performing Setup for Discipline in the 
SASIxp™ Setup and Administration Training Guide. Whether you have 
access to this option depends on the security level assigned to you. The 
option is dimmed if you do not have access.
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Create Disposition Table

This option converts disposition data from SASIxp software version 3.2 or 
earlier to the table and format used by SASIxp software version 3.5 and 
later. If you entered dispositions for any discipline item before installing 
SASIxp software version 3.5 or later, you must convert the old disposition 
information to a new format before adding information on additional 
dispositions.

Discipline Menu Reports

To print a discipline report from the Discipline pop-up menu, select the 
report name as shown in this table.

Discipline Overview Screen

The Discipline overview screen displays when you open the Discipline 
atom in the Discipline folder. This screen displays a matrix of all the 
incidents in a student's discipline record for the current school year. From 
this matrix, you can access detail screens to display specifics for a single 
discipline incident. 

Report Name Description

Discipline Report
(DIS01)

Discipline report by student with each 
student’s data on a separate page. This 
report also includes free-form comments from 
the Discipline atom.

Discipline Listing
(DIS02)

List of disciplinary incidents by student.

Student Demerits
(DIS03)

List of students with a specified number of 
demerits or more.

Discipline Summary 
(DIS04)

Total number of incidents for each discipline 
code and total number of incidents per 
month.

Discipline Report
(DIS01J)

The Discipline Report prints discipline 
incidents on a student-by-student basis.
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The top line of the Discipline screen and all detail screens fill automatically 
with the student's name, grade level, gender, ID, and track if the school 
uses tracks.

The Discipline matrix displays a row for each discipline infraction a student 
commits at school. Columns contain data such as incident dates, discipline 
codes, and a description of each incident. 

Double-click a row to access detail screens. These screens display data 
for a single discipline incident and also provide space for entering 
comments. See Discipline Detail Screen. Fields in the detail screen 
correspond to columns in the matrix. While you cannot view all columns in 
the Discipline matrix at the same time without scrolling, you can view all 
fields in a detail screen at once.

To update or delete discipline incidents, you can work from either the 
overview screen matrix or a detail screen. However, to add incidents, you 
must work from a detail screen. See Adding Discipline Incidents.'

Use the Discipline overview screen to add, update, or delete information 
from a student's discipline record. See See Data Menu Functions. and See 
Using the Discipline Screens..
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Discipline Overview Screen Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom are Last Name, First 
Name, Middle Name, Grd, Gen, and Student ID.

You can change this information from two atoms within the SASIxp 
software. See Defining and Using Student Demographics and Enrolling 
Students.

You can also change the header fields on the Discipline screens without 
changing them in other atoms. See the SASIxp™ File Definition Pro 
User’s Guide.

On the Discipline overview screen, the header fields are read-only.

Field Name Description

Total Disposition Days Total days of consequence time for all of this 
student’s disciplinary incidents as listed on 
this screen.

Total Disposition Hours Total hours of consequence time for all of this 
student’s disciplinary incidents as listed on 
this screen.

Total Demerits Total demerits for all of this student’s 
disciplinary incidents as listed on this screen.

Total Incidents Total of this student’s disciplinary incidents as 
listed on this screen.

Ethnic Ethnicity code.

I/S Code

[Instructional Setting 
Code]

Instructional setting (regular or special 
education) as specified in the Student atom.

Disciplinary User Code 
(Disc User Code)

User-defined disciplinary code (from the DUC 
table).

Ln

[Line Number]

Line number for each incident row. 

Click the line number to highlight and select a 
row. Double-click it to display the detail 
screen for a discipline incident.
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Incid Date

[Incident Date]

Date the discipline incident occurred.

Num
(Incd #)

[Incident Number]

Number of disciplinary incident. This value 
increments automatically when new incidents 
are added.

Cd
(Disc Cd, Des Cd)

[Discipline Code]

Numeric discipline code for each discipline 
infraction a student commits. This field is 
required.

Codes, descriptions, security levels, and 
demerits are defined in the Discipline Codes 
atom.

Description
(Disc Description)

[Discipline Description]

Description corresponding to the numeric 
discipline code and entered automatically 
when you select that code. 

Descriptions are defined with the codes in the 
Discipline Codes atom and cannot be 
changed on this screen.

Disposition Code
(Disp Cd, Disposition)

Abbreviation for the consequence, or 
disciplinary action, selected from the pop-up 
list.

Disposition codes are defined in the 
Disposition Table in the Tables atom.

Shading in this field indicates more than one 
disposition for this incident.

Disposition Des
(Disp Description, 
Disp Desc)

[Disposition Description]

The full description of the disciplinary action 
listed in abbreviated form in the Disposition 
Code field.

Disposition Num
(Disp #, Disp Num)

[Disposition Number]

Number of the disposition for this incident. 
Disciplinary incidents can have multiple 
dispositions.

Shading in this field indicates more than one 
disposition for this incident.

Field Name Description
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Incid Loc

[Incident Location]

Where the incident took place.

Demerits
(Dmt)

Number of demerits for each incident. 

Demerits are entered automatically when you 
select the discipline code (Cd on the 
Discipline screen), but you can modify them 
as needed. 

Demerits are defined with the codes in the 
Discipline Codes atom.

Referred By Name of the person who alerted the school 
office to the incident.

Refer Date Date the incident was referred to the office.

S/L

[Security Level]

Security level (0-9) required for access to 
information about the incident. The higher the 
security level, the more limited the access. 

You cannot view data for an incident if your 
security level is lower than the security level 
for that incident.

Security levels for infractions are defined with 
codes in the Discipline Codes atom. 
Discipline security clearance levels are 
defined in the Dis Sec Lvl (Discipline Security 
Level) field in the User atom.

Action Setting
(Act Setting)

ID the setting or campus where the 
disciplinary action took place.

Action Length 
(Act Length, Len)

Length in hours or days of the actual 
disciplinary action.

Field Name Description
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Discipline Detail Screen

The Discipline detail screen displays information for a single disciplinary 
incident. Access the detail screen by double-clicking the line number of 
any discipline record in the Discipline overview screen.

Diff. Reason 
(Rsn, Diff Reasons)

[Different Reason]

Code for the reason, if the actual length of 
the disciplinary action differs from the days 
and hours assigned in Day and Hours on the 
Discipline detail screen and Disp Days and 
Disp Hrs on the Disposition screen. 

For example, if a student was assigned a 
five-day suspension but served only three 
days, a code is needed to explain the 
difference. 

Values for this field come from the DLD table.

Field Name Description
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Fields in this detail screen are the same as fields in the Discipline overview 
screen; however, the detail screen also includes a Comments field. Use 
this screen to add or update a student's discipline record. See Data Menu 
Functions.

Discipline Detail Screen Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom are Last Name, First 
Name, Middle Name, Grd, Gen, and Student ID.

You can change this information using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics and Enrolling 
Students. 

You can also change the header fields on the Discipline screens without 
changing them in other atoms. See the SASIxp™ File Definition Pro 
User’s Guide 

On the Discipline overview screen, the header fields are read-only.
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Field Name Description

Incid Date

[Incident Date]

Date each discipline incident occurred.

Incd #
(Num)

[Incident Number]

Number of disciplinary incident on a specific 
date. This value increments automatically as 
incidents are entered.

Incid Loc

[Incident Location]

Where the incident took place

Disc Cd 
(Cd, Des Cd)

[Discipline Code]

Numeric code for each discipline infraction a 
student commits. This field is required.

Codes, descriptions, security levels, and 
demerits are defined in the Discipline Codes 
atom. 

Disc Description
(Description)

[Discipline Description]

Description corresponding to the numeric 
discipline code and entered automatically 
when you select that code. 

Descriptions are defined with the codes in the 
Discipline Codes atom and cannot be 
changed on this screen.

Disp Cd 
(Disposition Code, 
Disposition)

Abbreviation for the consequence, or 
disciplinary action, selected from the pop-up 
list.

Disposition codes are defined in the 
Disposition Table in the Tables atom.

Shading in this field indicates more than one 
disposition for this incident.

Disp Description
(Disposition Des, 
Disp Desc)

[Disposition Description]

The full description of the disciplinary action 
listed in abbreviated form in the Description 
Code field.

Shading in this field indicates more than one 
disposition for this incident.
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Disp # 
(Disposition Num, 
Disp Num)

[Disposition Number]

Number of the disposition for this incident. 
Disciplinary incidents can have multiple 
dispositions.

Shading in this field indicates more than one 
disposition for this incident.

Day 
(Disp Days)

[Disposition Days]

Number of days for the disciplinary action for 
that incident.

Hours
(Disp Hrs)

[Disposition Hours]

Number of hours for the disciplinary action for 
that incident.

Dmt
(Demerits)

Demerits associated with the discipline for 
that incident. Demerits are defined in the 
Discipline Codes atom.

S/L

[Security Level]

Security level (0-9) required for access to 
information about the incident. The higher the 
security level, the more limited the access. 

You cannot view data for an incident if your 
security level is lower than the security level 
for that incident.

Security levels for infractions are defined with 
codes in the Discipline Codes atom. 
Discipline security clearance levels are 
defined in the Dis Sec Lvl (Discipline Security 
Level) field in the User atom.

Referred By Name of the person who alerted the school 
office to the incident.

Refer Date Date the incident was referred to the school 
office.

School School number.

Field Name Description
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Con
(Incd Context)

[Incident Context]

Context of the incident (from the ILC table):

! During school hours.
! Outside school hours at school-

sponsored activity.
! Outside school hours at non-school-

sponsored activity.

Report First Name First name designated in the incident report.

Report Last Name Last name designated in the incident report.

State Incd #

[State Incident Number]

Number assigned to incident on state 
incident report.

Ethnic Ethnicity code.

Action Setting 
(Act Setting)

ID number of the campus where the 
disciplinary action took place.

Len 
(Action Length, 
Act Length

Hours or days for the disciplinary action.

Rsn 
(Diff Reason, 
Diff Reasons)

[Different Reason]

Code for the reason, if the actual length of 
the disciplinary action differs from the days 
and hours assigned in Day and Hours on the 
Discipline detail screen and Disp Days and 
Disp Hrs on the Disposition screen.

For example, if a student was assigned a 
five-day suspension but served only three 
days, a code is needed to explain the 
difference. 

Values for this field come from the DLD table.

Disc User Code

[Discipline User Code]

User-defined discipline code (stored in the 
DUC table).

DisUC1

[Discipline User Code 1]

User-defined discipline code (stored in the 
DU1 table).

Field Name Description
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Disposition Screen

DisUC2

[Discipline User Code 2]

User-defined discipline code (stored in the 
DU2 table).

DisUC3

[Discipline User Code 3]

User-defined discipline code (stored in the 
DU3 table).

DisUC4

[Discipline User Code 4]

User-defined discipline code (stored in the 
DU4 table).

DisUC5

[Discipline User Code 5]

User-defined discipline code (stored in the 
DU5 table).

Comments User Comments

Field Name Description
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Disposition Fields

Field Name Description

Incid Date

[Incident Date]

Date each discipline incident occurred.

Incd#
(Num)

[Incident Number]

Number of disciplinary incident on a specific 
date. This value increments automatically as 
incidents are entered.

Des Cd
(Disc Cd, Cd)

[Discipline Code]

Numeric code for each discipline infraction a 
student commits. This field is required.

Codes, descriptions, security levels, and 
demerits are defined in the Discipline Codes 
atom.

Description
(Disposition Des, 
Disp Desc, 
Disp Description)

[Disposition Description]

The full description of the disciplinary action 
listed in abbreviated form in the Description 
Code field.

Shading in this field indicates more than one 
disposition for this incident.

Referred By Name of the person who alerted the school 
office to the incident.

Refer Date Date the incident was referred to the school 
office.

S/L

[Security Level]

Security level (0-9) required for access to 
information about the incident. The higher the 
security level, the more limited the access. 

You cannot view data for an incident if your 
security level is lower than the security level 
for that incident.

Security levels for infractions are defined with 
codes in the Discipline Codes atom. 
Discipline security clearance levels are 
defined in the Dis Sec Lvl (Discipline Security 
Level) field in the User atom.
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Ln

[Line Number]

Number of the line or row describing an 
incident.

Disposition
(Disposition Code, Disp 
Cd)

Abbreviation for the consequence, or 
disciplinary action, selected from the pop-up 
list.

Disposition codes are defined in the 
Disposition Table in the Tables atom.

Shading in this field indicates more than one 
disposition for this incident.

Disp Desc
(Disposition Des, 
Disp Description)

[Disposition Description]

The full description of the disciplinary action 
listed in abbreviated form in the Disposition 
Code field.

Shading in this field indicates more than one 
disposition for this incident.

Disp Num
(Disposition Num,
Disp #)

[Disposition Number]

Number of the disposition for this incident. 
Disciplinary incidents can have multiple 
dispositions.

Shading in this field indicates more than one 
disposition for this incident.

Disp Hrs
(Hours)

[Disposition Hours]

Number of hours for the disciplinary action for 
the incident.

Disp Days 
(Day)

[Disposition Days]

Number of days for the disciplinary action for 
the incident.

Strt Date Starting date for the disciplinary action for the 
incident.

End Date Ending date for the disciplinary action for the 
incident.

Field Name Description
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TimeIn Starting time of the disciplinary action for the 
incident.

Enter four digits, and the system completes 
the colon and the a.m. or p.m.

TimeOut Ending time of the disciplinary action for the 
incident.

Enter four digits, and the system enters the 
colon and the a.m. or p.m.

Action Taken By Name of the individual who carried out the 
disciplinary action for the incident.

Tch Conference

[Teacher Conference]

Indicates (Y or N) whether a teacher 
conference was held regarding the incident.

Pre Act

[Previous Action]

Any previous actions taken regarding this 
incident (from the PRV table). 

PrevAct2

[Previous Action 2]

Any additional previous actions taken 
regarding this incident (from the PRV table). 

Act Setting
(Action Setting)

Setting or campus of the disciplinary action.

Act Length
(Len, Action Length)

Length of the actual disciplinary action.

Diff Reasons
(Rsn, Diff. Reason)

Code for the reason, if the actual length of 
the disciplinary action differs from the days 
and hours assigned in Disp Days and Disp 
Hrs on the Disposition screen and Day and 
Hours on the Discipline detail screen.

For example, if a student was assigned a 
five-day suspension but only served three 
days, a code is needed to explain the 
difference.

Values for this field come from the DLD table.

Field Name Description
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Using the Discipline Screens

For general instructions on using the Discipline and Disposition screens, 
see Data Menu Functions. For specific instructions to add, delete, or 
update data using these screens, see the procedures that follow.

Converting Discipline Disposition Data

1. Open the Discipline atom.

2. From the Discipline menu, select Create Disposition Table.

3. Click Create to continue. The system displays a message in the 
Message Center when the conversion process is complete. Click 
Cancel to stop the process.

Adding Discipline Disposition Information

1. Open the Discipline atom and find the student record you want.

2. Click the line number (Ln) to highlight the incident for which you want 
to add disposition information. 

3. Click Disposition to display the Disposition screen.

4. Click Add.

5. Complete the fields as needed.

6. Click Save, or click Undo to erase the data.

7. Click Close.

Incd Context
(Con)

[Incident Context]

Context of the incident (from the ILC table):

! During school hours.
! Outside school hours at school-

sponsored activity.
! Outside school hours at non-school-

sponsored activity.

Notes Any comments on the disposition.

Field Name Description
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Adding Discipline Incidents

1. Open the Discipline atom and find the student record you want.

2. From the Data menu, select Add Incident to display a detail screen. 
The data shown in the top line of the matrix defaults to this screen and 
the Incid Date (Incident Date) field defaults to today’s date.

3. If the Incident occurred on a different date, backspace over the filled 
date and type the correct date.

4. In the Disc Cd (Discipline Code) field, select a discipline code from 
the list.

The code you select displays here and in the Cd (Code) field on the 
overview screen. The code description displays in the Disc Description 
(Discipline Description) field, the security level for the code displays in 
the S/L (Security Level) field, and demerits for the code display in the 
Dmts (Demerits) field.

If the discipline code you select is marked Y for credit in the Discipline 
Codes atom, the hours are recorded here as negative numbers and 
subtracted from the total hours for the student.

5. In the Referred by field, enter the name of the person who reported the 
incident.

6. In the remaining fields, enter any other available data or replace the 
default values as needed.

7. Click Save. The new incident displays in the matrix. To undo changes, 
click Undo.

8. Click Close.

Updating Discipline Incidents

1. Open the Discipline atom and find the record you want.

You can work from either the Discipline overview screen matrix or the 
detail screen for a single incident. To access the detail screen, double-
click the line number for that incident on the overview matrix.

2. Click the first field to be changed.

3. Type a new entry or select a new choice from a pop-up list.

Only discipline incidents at or below the Discipline security level 
assigned to you in your user record are displayed in Discipline records. 
Incidents coded at higher security levels are not shown.
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4. Tab to any additional fields you want to change and type or select new 
data.

5. To save new entries when working in the Discipline matrix, click Save. 
You must save before you can view the detail screen. To undo 
changes, click Undo.

6. Click Close.

7. If you have been working in a detail screen, click Close to return to the 
Discipline overview screen matrix.

Deleting Discipline Incidents

1. Open the Discipline atom and find the student record you want.

2. Click the line number for the incident you want.

3. From the Data menu, select Delete Incident. The row for the incident is 
cleared from the matrix and the number for the incident is removed 
from the Multi-Record Selection Bar in detail screens.

4. Click Save to store your results or click Undo to undo the changes.

5. Click Close.
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Incident Reporting

Using Incident Reporting, the school site personnel can record and 
produce corresponding reports of school crime incidents with varying 
levels of details, including the number of offenders and victims per 
incident. The Incident Reporting folder resides in the Discipline folder and 
contains two atoms for Incident Reporting Setup and Incident Reporting: 

! Use the Incident Reporting Setup atom to customize the Incident 
Reporting atom with parameters that will ensure your system complies 
with individual State and Federal Incident Report requirements.

! Use the Incident Reporting atom to collect and maintain data items 
related to school incidents in order to comply with individual State and 
Federal Incident Report requirements.

Working with Incident Reporting Setup atom
Incident Reporting Setup atom enables the user to define or modify 
parameters to customize the Incident Reporting atom. The parameters 
specified here will be provided to the user on the Incident Reporting atom 
screens for selection.
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Incident Reporting Setup Options

This section describes how to set up the Incident Reporting system 
according to your school’s needs. 

The Incident Reporting Setup matrix contains standard read-only header 
fields to identify the school that is currently logged in. The header fields are

The Incident Reporting Setup matrix contains tabs for:

! General (information on offenders, victims, involvement codes, and 
security measures)

! Reporting Periods
! Incident Reasons
! Services Offered

Field Name Description

Sch # The School Number from the School atom.

School Name The School Name from the School atom.

Alternate # The Alternate School Number from the 
School atom.
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General Tab

Use this tab to add or modify general information applicable to every 
incident that is stored using Incident Reporting. This tab includes number 
of students enrolled, number of students impacted, maximum number of 
victims and offenders allowed per incident, involvement codes, and 
security measures.

General Fields

Field Name Description

Enrollment Number of students enrolled.

No. of Students 
Impacted

The number of students who were served or 
impacted by the prevention services or 
activities during the current school year. This 
value should not be higher than the value in 
the Enrollment field.
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When you enter or select data in any field, click Save to record the addition 
or changes to the General Tab, or click Undo to cancel all changes before 
moving to another tab.

Maximum No. of Victims 
Per Incident

Maximum permissible number of victims that 
can be specified in an incident. A zero or a 
blank value indicates no limit.

Maximum No. of 
Offenders Per Incident

Maximum permissible number of offenders 
that can be specified in an incident. A zero or 
a blank value indicates no limit.

Auto-Generate Incident 
ID

This check box is selected by default to auto-
generate Incident ID. To manually assign 
Incident ID, clear the check box.

Note: If this check box is reselected after 
clearing it, a message related to database 
problems displays asking confirmation from 
the user whether to continue with the 
reselected auto-generate option.

Student Involvement Select this check box to indicate whether 
students are involved in designing, delivering, 
or critiquing drug or violence prevention 
programs.

Involvement Codes Relevant community involvement codes that 
the school participates in. At most, eight 
codes can be selected simultaneously. 

Table IRA, Involvement Code, defines the 
values for the pop-up list in this field.

Security Measures Relevant security measures taken at the 
school. At most, eight codes can be selected 
simultaneously. 

Table IRB, Security Measures, defines the 
values for the pop-up list in this field.

Field Name Description
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Reporting Periods Tab

Use this tab to add and maintain the Incident Reporting periods. Data in 
this matrix includes titles and date ranges for the incident reporting 
periods.

Reporting Fields

Field Name Description

Ln Line number of the reporting periods.

Per No Unique period number to identify a reporting 
period.

Period Title Title for the reporting period.

Starting Date Starting date of the reporting period. This 
field is mandatory.

Ending Date Ending date of the reporting period.
This field is mandatory and will be validated 
to ensure that it occurs on or after the starting 
date.
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Adding/Modifying Reporting Periods

1. Open the Incident Reporting Setup atom.

2. Click the Reporting Periods tab.

3. To add a new record, select Add Period from the Data menu, or press 
Ctrl+A.

4. To modify an existing record, click on any field withinthe relevant 
record.

5. Enter or modify data in the relevant fields.

6. Click Save to record the addition or changes made to this tab, or click 
Undo to cancel all changes before moving to another tab.

Incident Reasons Tab

Use the matrix in the Incident Reasons tab to define incident codes, their 
descriptions, and other related information.
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Incident Reasons Fields

Adding/modifying Incident Reasons

1. Open the Incident Reporting Setup atom.

2. Click the Incident Reasons tab.

3. To add a new record, select Add Reason from the Data menu, or press 
Ctrl+A.

4. To modify an existing record, click on any field of the relevant record.

5. Enter or modify data in the relevant fields.

6. Click Save to record the addition or changes made to this tab, or click 
Undo to cancel all changes before moving to another tab.

Field Name Description

Ln Line number of the Incident Reasons matrix.

Code The Incident Code field defines the code 
value of the incident reasons to be used. 

Note: Once defined, these codes will be 
used as the pull-down menu for Incident 
Code pop-up in the Incident Reporting atom.

Alt Code The Alternate Code field defines an 
additional code to be associated with an 
incident.

Incident Title Short description of the Incident Code.

Incident Type Select options from a pop-up list to define the 
type of incident. 

Table IRC, Incident Type, contains the codes 
for this pop-up list.

Include in Reports Click the cell to toggle between X (Yes) and 
blank (No) to indicate whether this incident 
code is to be reported.
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Services Offered Tab

Defines the services offered codes, descriptions, and other related 
information.
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Services Offered Fields

Field Name Description

Ln Line number of the Services Offered matrix.

Code Defines the code values of the Services 
Offered.

Service Description Short description for the Services Offered.

Service Type A drop down list in which the user can define 
a classification of the service. 

Example: This table can be used to identify if 
a service is education-related.

Table IRD, Service Type, contains the codes 
for this pop-up list.

Funding 1, Funding 2 A dropdown list that denotes the funding that 
this service type has.

Example: SDSFCA, or state specific.

Table IRE, Service Funding, contains the 
funding codes for this pop-up list.

Include in Reports Click the cell to toggle between X (Yes) and 
blank (No) to indicate whether this Incident 
Code is to be reported.

UC 1, UC 2, UC 3 Fields defined by the users to give 
themselves greater flexibility in the use of 
Incident Reporting.
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Adding/Modifying Services Offered

1. Open the Incident Reporting Setup atom.

2. Click the Services Offered tab.

3. To add a new record, select Add Service from the Data menu, or press 
Ctrl+A.

4. To modify an existing record, click on any field of the relevant record.

5. Enter or modify data in the relevant fields.

6. Click Save to record the addition or changes made to this tab, or click 
Undo to cancel all changes before you click on another tab.
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Working with Incident Reporting atom
The Incident Reporting atom enables the school site personnel to collect 
data related to school crime incidents and record it in their school 
administrative software package. Incident Reporting differs from Student 
Discipline infractions because the data is collected on the basis of incident, 
not by student.

Incident Reporting Options

The Incident Reporting atom consists of eight fields and four tabs:

! Incident Identification (8 fields)
! General
! Victim Profile
! Offender Profile
! Related Factors

The values in the pop-up lists seen on different screens within this atom 
are populated based on the parameters set in the Incident Reporting 
Setup atom. See Working with Incident Reporting Setup atom for more 
information.

Incident Identification

This pane contains fields to identify the incident occurrence.
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Incident Identification Fields

Click Save to record the addition or changes made to this pane, or click 
Undo to cancel all changes before moving to another tab.

Field Name Description

Incident ID Unique Incident ID that can be auto-
generated or manually entered.

Note: Once set to manual, the ID should not 
be set to auto.

Rel. Incident ID The Related Incident ID allows a user to 
manually link the current incident with other 
incidents.

Alternate ID An additional ID field that could be used for 
an Alternate ID as per user’s choice.

Date The date on which the incident occurred. This 
field defaults to the system date but can be 
modified.

When/Time Indicates the time of the day that an incident 
occurred. 

Table IRF, Time Period, contains the values 
for this pop-up list.

Incident Cd Indicates the type of incident. 

Table IRC, Incident Reasons, contains the 
values for this pop-up list.

Description Description that defaults to the short 
description of the Incident Code. This can be 
overwritten to be replaced or to include a new 
description.

Where/Location Indicates the location where an incident 
occurred.

Table IRL, Incident Location, contains the 
values for this pop-up list.
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General Tab

This tab contains fields to record data items to describe a specific incident.
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General Fields

Field Name Description

Action Taken Indicates what action was taken as a result of 
this incident.

Table IRG, Action Taken, contains the values 
for this pop-up list.

Other Action Taken Defines information on additional action 
taken.

Parent Select this check box to indicate whether 
parents of students were involved in this 
incident.

Employee Select this checkbox to indicate if an 
employee was involved in this incident.

Victims Involved Select this checkbox to indicate if there were 
any victims as a result of this incident.

Other Person Select this checkbox to indicate if a person 
other than a student or employee was 
involved in this incident.

Unknown Person Select this checkbox to indicate if an 
unknown person was involved in this 
incident.

Police called Select this checkbox to indicate if the Police 
were called as a result of this incident.

Arrests made Select this checkbox to indicate if any arrests 
were made as a result of this incident.

Charges pressed Select this checkbox to indicate if any 
charges were pressed against the offenders 
in this incident.
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Reported By Indicates the person who reported this 
incident. Table IRR contains defined values 
that are referenced for selection from a pop-
up list.

Note: These values can be modified in the 
Table IRR as per user requirements and 
would change accordingly in the pop-up list.

Est. Property Damage Select from this pop-up to indicate estimated 
property damaged as a result of this incident. 

Table IRI, Estimated Cost, contains the 
values for this pop-up list.

Actual Cost Indicates the actual cost of the property that 
was damaged.

UC 1, UC 2 User can record any additional information 
about the incident in these two fields.

Field Name Description
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To find, add or delete an incident:

1. Open the Incident Reporting atom.

2. Click the General tab.

3. To find an incident, from Data menu, select Find Incident, or press 
Ctrl+F.

4. To add an incident, from Data menu, select Add Incident or press 
Ctrl+A.

5. To delete an incident, from Data menu, select Delete Incident. 

6. Click Save to record the addition, modification or deletion made to this 
tab, or click Undo to cancel all changes before moving to another tab.

Victims Tab

Determines the demographic and other information used to identify the 
victims of an incident.
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Victims Fields

Field Name Description

Ln Line number of the Victim Profile matrix.

Gen Indicates the gender of the victim. 

Table GEN contains the values for this pop-
up list.

Age Indicates the age of the victim. 

Table IRJ, Age, contains the values for this 
pop-up list.

Eth Indicates the ethnicity of the victim. Table 
ETH contains the values for this pop-up list.

Type of Victim Indicates the type of victim. 

Example: classified employee, parent 
volunteer etc. 

Table IRK, Victim/Offender Type contains the 
values for this pop-up list.

Est. Costs Indicates the estimated costs (in dollars) to 
the victim as a result of this incident.

Table IRI, Estimated Cost, contains the 
values for this pop-up list.

Act. Costs Indicates the actual costs (in dollars) to the 
victim as a result of this incident.

Civil Select this checkbox to indicate whether civil 
damages are being pursued by the victim of 
this incident.

SpEd Indicates values for Special Education codes. 

Table IRS, Special Education, contains 
defined values for this pop-up list.

See Special Education Codes
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Special Education Codes

Services 1, Services 2 Indicates the services provided to the victim 
of this incident.

Table IRD, Services Offered, provides the 
values for these two pop-up lists.

Value Description

NSE Not Special Education

GT Gifted

AUT Autism

TBI Traumatic Brain Injury

MR Mental Retardation

SLD Special Learning Disabilities

HI Hearing Impaired

VI Visually Impaired

OHI Other Health Impaired

OI Orthopedic Impaired

SLI Speech/Language Impaired

DB Deaf/Blind

EC Emotionally Conflicted

DD Developmentally Delayed

MD Multiple Disabilities

ED Emotionally Disturbed

Field Name Description
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Adding/modifying Victims Profile

1. Open the Incident Reporting atom.

2. Click the Victims tab.

3. To add a new record, select Add Victim from the Data menu, or press 
Ctrl+A.

4. To modify an existing record, click on any field of the relevant record.

5. Enter or modify data in the relevant fields.

6. Click Save to record the addition or changes made to this tab, or click 
Undo to cancel all changes before moving to another tab.

Note: The user is not allowed to add more victims than the maximum 
number of victims per incident which is specified on the General tab of the 
Incident Reporting Setup atom.

Offenders Tab

Determines the demographic and other information used to identify a 
specific offender of an incident.
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Offenders Fields

Field Name Description

Ln Line number of the Offender Profile matrix.

Gen Indicates the gender of the offender. Table 
GEN contains the values for this pop-up list.

Age Indicates the age of the offender. 

Table IRJ, Age, contains the values for this 
pop-up list.

Eth Indicates the ethnicity of the offender. Table 
ETH contains the values for this pop-up list.

Type of Offender Indicates the type of offender.

Example: classified employee, parent 
volunteer etc. 

Table IRK, Victim/Offender Type, contains the 
values for this pop-up list.

SpEd Indicates values for Special Education codes. 

Table IRS, Special Education, contains 
defined values for this pop-up list.

See Special Education Codes

Services 1, Services 2 Indicate the services provided to the offender. 

Table IRD, Services Offered, provides the 
values for these pop-up lists.

Days Sus Indicates the number of days the offender 
was suspended as a result of this incident.

Days Exp Indicates the number of days the offender 
was expelled as a result of this incident.

Days Alt Indicates the number of days the offender 
was in an Alternate Placement Program as a 
result of this incident.

Corp Select this checkbox to indicate if the 
offender received corporal punishment as a 
result of this incident.
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Adding/modifying Offenders Profile

1. Open the Incident Reporting atom.

2. Click the Offenders tab.

3. To add a new record, select Add Offender from the Data menu, or 
press Ctrl+A.

4. To modify an existing record, click on any field of the relevant record.

5. Enter or modify data in the relevant fields.

6. Click Save to record the addition or changes made to this tab, or click 
Undo to cancel all changes before moving to another tab.

Note: The user is not allowed to add more offenders than the maximum 
number of offenders per incident which is specified on the General tab of 
the Incident Reporting Setup atom.

Days Alt Placement SE Indicates the number of days the special 
education offender was in an Alternate 
Placement Program as a result of this 
incident.

Hearing Officer Select this checkbox to indicate if a Hearing 
Officer removed the offender from the normal 
educational setting.

Field Name Description
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Scheduling Conferences

The Conference atom (in the Student Info folder) enables you to schedule, 
maintain, and view conference data for specific students. Conference 
records may indicate the date and subject of a student conference, and 
which personnel attended the conference.

Conference Screen

The Conference screen displays data related to conferences for a 
particular student. It includes a row for each specific conference. Use the 
conference screen to add, update, or delete a student's conference record. 
See Data Menu Functions.

Conference Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.
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You can change this data using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

Ln Line number for each conference record.

Date Date for the conference record (defaults to 
the current date).

Cd Code for the conference type. Select from the 
pop-up list of items defined in the Conference 
Codes atom.

Description Conference code description is read-only.

Cn# Counselor Number. This number defaults to 
the counselor number on the student’s 
record, if one exists, but can be changed.

Cn Name Name associated with the counselor number 
selected in the previous field.

Grd Grade level of the student when this 
conference took place. Defaults to the 
student’s current grade, but you can change 
the grade.

S/L Security level assigned to the conference 
code you selected in the Cd field. Read-only 
field.

Referred by Person who referred the student for a 
conference.

Refer Date Date of the conference referral.

Notif Date Date the student or parents received 
notification of a scheduled conference.

Fol Up Date Date to perform follow-up to the conference.
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Adding Conference Records

1. Open the Conference atom.

2. Locate the student record that you want.

3. From the Data menu, select Add Conference. The system displays the 
Conference Detail screen and enters the current date in the Date field. 
You can change the date.

4. In the Cd field, select a conference code from the pop-up list.

5. In the Cn# field, verify that the correct counselor number displays. 
Change the number if required. The system displays the counselor 
name.

6. For all other fields in the Conference Detail screen, type data or select 
an item from the pop-up list. 

7. Click Save.

Deleting Conference Records

1. Open the Conference atom and display the Conference screen.

2. Locate the student record that you want.

3. Click the line number (Ln) for the row of information to be deleted. 
Ensure that the row is highlighted.

4. From the Data menu, select Delete Conference.

5. Click Save to delete the conference record from the database.

Conference Detail Screen

The Conference Detail screen displays information for a single student 
conference. Fields in this screen correspond to columns in the Conference 
screen. The detail screen also includes a Comments field for additional 
conference information. Display the Conference Detail screen by double-
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clicking the line number of any record in the Conference screen. Use this 
screen to add, update, or delete a student's conference records. See Data 
Menu Functions.

Conference Detail Field

Conference Menu Option

Conference Codes

These codes activate the Conference Codes atom enabling you to view 
the list of school-defined conference codes in the Conference screen. Use 
this list to add, delete, or modify codes. You can only view codes that are 
at, or below, the Conference Security Level assigned to you.

Field Name Description

Comments Text field where you can enter up to 32,000 
characters to record information about the 
conference. This field is available only on the 
detail screen.
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Using Generic Selection

The Generic Selection atom (in the Utilities folder) is a tool that provides 
fast access to records for one or more files within a specific atom by 
displaying lists of student names based criteria you specified. Once a 
student list displays, select the student names for which you want to locate 
records. Then drag and drop the student names onto the Student atom 
icon to simultaneously open their records.

Generic Selection Screen

Generic Selection Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.
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You can change this data using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Buttons on Generic Selection Form

Field Name Description

Locate Performs search based on student 
information entered. For example, type W to 
find students whose last name begins with W 
or type Wilson to find students whose last 
name is Wilson. The system locates records 
more quickly with more specific search data.

Search File Performs search based on file selected. For 
example, to access records for specific 
teachers, select the ATCH-Teacher option. A 
list of key data for this atom displays in the 
Available Selections field. Notice that the file 
name in the title bar at the top of the screen 
changes as different search files you select.

Available Selections Displays a list of records for the selected 
search file. Highlight items and move them to 
the Selections field. The matrix title displays 
the number of items available for selection.

Selections Selected items from the Available Selections 
field display in this field once you move them. 
From this field you drag and drop selections 
into the atom containing the records you want 
to access. The matrix title bar displays the 
number of records selected at any time.

Button Description

>> Moves highlighted items from the Available 
Selections list to the Selections list.

<< Returns highlighted items from the Selections 
list to the Available Selections list.
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Navigating within Generic Selection

1. Open the Generic Selection atom.

2. In the Search File field, select a search file from the pop-up list.

3. Find the items you want.

! Enter the key data in the Locate field and press Enter.
! Scroll until the item displays, then release the mouse, displaying 

the selection in the Available Selections list.

4. Transfer items from the Available Selections list to the Selections list 
using one of these methods:

! Click to highlight one item or hold down the Shift key and highlight 
several items. Click the >> button.

! Double-click each item you want to move.

5. To open records for the selected items, highlight all items in the 
Selections list. Drag and drop these items onto an atom icon.

! Dropping a single item onto a closed atom icon opens the atom to 
the required record.

! Dropping a single item onto an open atom icon closes the current 
record and opens the record for the item just dropped.

! Dropping multiple items onto a closed atom icon displays a list 
containing the selected items (key data). You can open one record 
at a time or multiple records.

Double-click the item to display the data record to open a single 
record.

Scroll Bars If a scroll bar displays to the right of the 
Available Selections or Selections column, 
use it to quickly review items and locate a 
specific one.

Add All Copies all items from the Available 
Selections list to the Selections list.

Remove All Returns all items in Selections list and places 
to the Available Selections list.

Done Closes the Generic Selection atom.

Button Description
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Highlight all items, then click the Open key to open multiple 
records. Multiple records cascade in ascending order.

! Dropping multiple items onto an open icon atom opens a screen for 
each record. Multiple records cascade in ascending order.

Notice that the key data displays in the screen’s title bar to identify 
the record. Click the title bar to move a record to the front.
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Establishing Student Groups

The Student Groups atom (in the Student Info folder) enables you to add 
students to groups such as marching band, girls’ basketball, or the 
National Honor Society. Organizing students into group lists enables you 
to run reports by group and to mass change attendance by group. For 
example, if the marching band is not present one day due to participation 
in a battle of the bands event, you can use the Mass Change Attendance 
function to mark records for all band members with Activity for that day.

Once your school has set up a list of student groups in the Groups table 
(GRP) in the Tables Definition atom, you can add students to groups at 
any time. Take this action at the beginning of the school year or as 
students join groups during the course of the year.

Groups Screen

The Groups screen lists all students in a selected group. Select different 
groups from the list in the Student Group field. The system adds students 
to groups in alphabetical order. You can sort them by Student ID, Start 
Date, or End Date by double-clicking headings for these field columns.
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Groups Fields

Field Name Description

Student Group
(GRP table)

Groups set up for your school in the Groups 
table (GRP) in the Tables Definition atom. 
When you select a group from the list, 
currently participants display. All functions 
you perform in the screen (such as adding, 
inactivating, or deleting students) apply to the 
specified student group.

Default Date Enables you to specify a date for the system 
to enter automatically in Start Date cells or 
End Date cells. These dates become defaults 
that are used when you add students to a 
group or inactivate students from a group. 
You can change these dates. If you don’t 
enter any dates, the system uses the current 
date.

Select Arrow Opens the Generic Selection atom. Use the 
Generic Selection atom to add students to 
each group.

Student ID Unique identification number for each student 
in the selected group. Click this to select a 
student.

Student Name of each student in the selected group.

Start Date Date a student joined the group. The system 
automatically enters the date displayed in the 
Default Date field in the top line (you can 
change the date).

End Date Date that a student left the group. Students 
with end dates are no longer active in the 
group. Inactive students are not included on 
group reports or in mass change attendance 
by group. The system automatically enters 
the date displayed in the Default Date field 
when you select Inactivate Student from the 
Data menu (you can change this date).
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Adding Students to Groups

The most efficient way to add students to a group is to identify them from 
the Generic Selection atom in the Utilities folder. You can also drag and 
drop one or more students from anywhere in the system, including a 
matrix produced by a Find or Query.

1. Open the Student Groups atom.

2. In the Student Group field, select a group from the pop-up list. The 
system automatically enters the current date in the Default Date field, 
which represents the start date for all students you are about to enter. 
You can change this date.

3. Add students using one of these methods:

! Click the Select Arrow to open the Generic Selection atom. Click 
and highlight one student record or hold down the Shift key and 
click to highlight multiple records. Then click the arrow to put 
selected students on the Selections list. You also can put students 
on this list by double-clicking their records. Click Done in the 
Generic Selection atom.

! Produce a matrix of student names using a Find or Query. Click to 
highlight one student record or hold down the Shift key and click to 
highlight multiple records. Drag and drop the selected records onto 
the Student Groups matrix.

4. Click Save.

Inactivating and Deleting Group Members

You can use the Student Groups atom to inactivate and delete students 
from groups. Inactivating a student enables you to determine that the 
student once belonged to the group although the student is not included in 
group reports or affected by mass change attendance by group. Deleting a 
student erases any record of that student’s group participation. See Data 
Menu Functions.

Inactivating Students in Groups

1. Open the Student Groups atom.

2. In the Student Group field, select a group from the pop-up list. The 
system automatically enters the current date in the Default Date field, 
which represents the end date for all students that you inactivate. You 
can change this date.
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3. Click the Student ID number of the student to be inactivated. Ensure 
that the row is highlighted. To select multiple students, hold down the 
Shift key and click student ID numbers.

4. From the Data menu, select Inactivate Student. The system 
automatically enters the specified default date in the End Date field for 
each selected student.

5. Click Save to inactivate students.
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Identifying Home Languages

The Home Language atom (in the Student Info folder) enables you to 
record data about what languages are used to communicate in a student’s 
home. Information includes the first language learned by the student, the 
language spoken to the student at home, and the language spoken by 
adults at home. This atom also records information about a student’s entry 
and residency in the United States.

Complete or update a home language record at any time, according to the 
needs of your school. See Data Menu Functions.

The Home Language atom consists of two screens:

! Home Language Info Screen
! Home Language Comments Screen

Home Language Info Screen
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Home Language Info Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.

On this screen the header fields are read-only.

Field Name Description

Birth Place Student’s place of birth (view only).

Birthdate Student’s date of birth (view only). 

Age Student’s age (view only).

Ethnic Code
(ETH table)

Student’s ethnic code (view only).

PrimLang
(LNG table)

Language in which the student is most fluent 
(view only).

Class
(ENG table)

Indicates a student’s English proficiency 
classification.

Program
(ENG table)

Indicates whether the student is enrolled in a 
special program like LEP. If you select Yes, 
an X displays in the field. If you select No, the 
field remains blank. This field defaults from 
the Program field on Tab 2 of the Student 
atom.

First Language 
Learned
(LNG table)

Language student first learned to speak in 
the home.

Language Spoken
by Student at Home
(LNG table)

Language student speaks at home.

Language Spoken to
Student at Home
(LNG table)

The language adults speak to the student in 
the home.
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Language Spoken
by Adults at Home
(LNG table)

The language adults speak and read in the 
home. This is the correspondence language 
to use when writing letters to the student’s 
parents.

U.S. Entry Date Date that the student entered the United 
States.

Country
(CTR table)

Student’s country of birth.

U.S. School Entry Date First date that the student enrolled in a school 
in the United States.

Form I-20, I-94, ARC A selected checkbox for any of these forms 
indicates that the selected Immigration form 
has been filed for the student.

Other Form Displays the description of a form other than 
I-20, I-94, and ARC that has been filed for the 
student.

Number Number corresponding to the form 
description entered in the Other Form field.

Date Date that the form described in the Other 
Form field was filed for the student.

Field Name Description
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Home Language Comments Screen

The Home Language Comments screen exists primarily so that you can 
record additional data about a student’s home language environment. You 
might note information such as a student’s need for an interpreter.

Printing Home Language (AHLN) Data

You can print home language records in the Home Language file (AHLN) 
using the Query atom.

To send the query results to a file, select Export File from the Data menu in 
the Query atom. This sends a file containing the query results to the 
destination you select. You can then format the file using Teach Text 
(Macintosh) or Notepad (Windows).

Sample AHLN Query Statement

DISPLAY AHLN ASTU LastName FirstName PermNum Language2
IF Language2 <> " "
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Recording Student Fees

The Fees atom (in the Student Info folder) enables you to record and track 
any school fees that a student incurs, such as lab fees or library fines. You 
can track any payments and balances due. The AutoPay feature enables 
you to mark all unpaid fees as paid in full for a particular student. Use the 
Fees atom to charge, modify, or delete student fees. See Data Menu 
Functions.

The Fees atom consists of two screens:

! Fees Screen
! Fees Detail Screen

Fees Screen

Fees Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.
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You can change this data using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

Total Fees Total amount of all fees owed by the student.

Total Paid Total amount of the fees owed that has been 
paid.

Total Due Balance that is still owed on all fees.

Fee Date Date the student fee was charged. The 
system default is the current date but you can 
change it).

Code Fee code. Fee codes are established in the 
Fee Codes atom and are already associated 
with descriptions and amounts.

Description The fee code description (displays 
automatically when you exit the Code field). 
You can change this if necessary.

Fee The fee amount (displays automatically when 
you exit the Code field). You can change this 
if necessary.

Pay Date Receipt date of student fee (defaults to 
system date but you can change it).

Payment Dollar amount received from a student 
toward fees due.

Balance Dollar amount due from the student toward 
fees due.

Type Fee type defined in the Fee Code atom for 
each specified fee. You can overwrite a fee 
type with your own fee type.

Comment Text field that accepts up to 50 characters.
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Fees Detail Screen

Paying Student Fees

1. Open the Student Fees atom.

2. Find the student’s record.

3. In the Payment field, enter the payment amount.

4. Click Save.

If the payment amount equals the entire balance due for a particular 
fee, highlight the entire fee row and click AutoPay so that the system 
automatically completes the Payment field and enters the current 
date in the Pay Date field.

If the payment amount equals the entire amount for all outstanding 
fee balances, highlight all rows in the Fees matrix and click AutoPay 
so that the system automatically completes all Payment fields and 
enters the current date in all Pay Date fields.
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Fees Menu Report

Fees Menu Option

Fee Codes

Opens the Fee Codes atom to view the list of fee codes. You can add 
codes as necessary.

Report Name Description

Fees Report
(FEE01)

This report displays a list of all students who 
owe fees. There is a summary and detail 
version of this report.
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Entering GATE Student Information

The GATE atom (in the Student Info folder) enables you track gifted and 
talented program information and tests taken by a student. Add, modify, or 
delete gifted and talented records using the Data menu. See Data Menu 
Functions.

GATE Screen

GATE Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.
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You can change this data using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

GATE Date Displays the date when the student entered 
the Gifted and Talented program.

GATE Cd Indicates the GATE code for the test taken by 
the student.

Test Name Displays the name of the test taken by the 
student.

Test Year Indicates the year that the student took the 
test.

WISC Verbal Indicates the student’s verbal score on the 
Wechsler Intelligence Scale for Children 
(WISC) exam.

WISC Performance Indicates the student’s WISC performance 
score.

WISC Full Score Indicates the student’s total WISC score.

Stanford Binet Indicates the student’s score on the Stanford 
Binet test.

Other Displays comments about the student’s 
Gifted and Talented program participation.

General Intellect
(G01 table)

Indicates whether the student has 
demonstrated superior intelligence, potential 
in several fields, or an ability to perform 
complex mental tasks.

Specified Subject
(G02 table)

Indicates whether the student has 
demonstrated superior ability or potential in a 
specific subject area.

Creative Thinking
(G03 table)

Indicates whether the student has 
demonstrated outstanding imagination, 
innovation, or creative reasoning skill.
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Leadership
(G04 table)

Indicate whether the student has 
demonstrated a natural ability to influence 
others.

Visual/Performing Art
(G05 table)

Indicate whether the student has 
demonstrated superior ability in art, music, 
drama, or other performing arts.

Psycho/Motor
(G06 table)

Indicates whether the student has 
demonstrated superior ability in either fine 
motor skills or athletic endeavors.

Field Name Description
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Maintaining Student Service Programs

The Student Service Program atom (in the Student Info folder) enables 
you to track student enrollment in your school’s service programs. You can 
track dates that students enter and exit programs as well as student 
reasons for leaving the programs. Service programs and service program 
levels are defined in the Service Program Definition atom.

The Student Service Program enables you to run a process at the end of 
the school year that automatically enters exit codes and exit dates for 
student participating in all active service programs. At the beginning of the 
next school year, you can run a process to re-enroll students in programs 
in which they previously participated.

Using the Service Program
You can add or remove students from service programs at your school 
using this function. Once a student is added to a service program, you can 
modify information in that record, whether the student’s participation is 
current or occurred previously. See Data Menu Functions.

You cannot use the Student Service Program unless the service 
program exit reason codes have been defined in the Tables Definition 
atom. The exit reason codes are contained in the PXR table.
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Student Service Program Screen

Student Service Program Fields

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom begin with Last Name 
and end with Student ID.

You can change this data using one of two atoms within the SASIxp 
software. See Defining and Using Student Demographics. See Enrolling 
Students. On this screen the header fields are read-only.

Field Name Description

Ln Line number for the service program.

Pgm ID Service program identification number.

Program Name Name of the service program.

Grade Grade at which the student entered the 
service program.

Level Service program level.

Entry Date Date the student entered the service 
program.
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Student Service Program Detail Screen

The Student Service Program detail screen displays data related to a 
service program. The fields in this screen correspond to columns in the 
Student Service Program screen. Access the detailed screen by double-
clicking the line number of any record in the Student Service Program 

Exit Reason Reason the student left the service program.

Exit Date Date the student left the service program.

Sch# Number of the school offering the program.

School Name of the school that offers the program.

Tch Num Teacher’s permanent identification number. 
Selections from the pop-up list include all 
valid teacher numbers. This information 
displays from the ASPS file.

Tch Serv Type Teacher service type. This field is linked to 
the Tch Num field. As soon as you enter a 
Teacher Number, this field automatically 
populates with the Teacher Service Type that 
corresponds to that Teacher Number.

Teacher Name Abbreviated teacher’s name This field is 
linked to the Tch Num field. When you enter a 
Teacher Number, this field automatically 
populates with the Teacher Name that 
corresponds to that Teacher Number.

Minutes Amount of minutes each week the student 
spends on the identified program.

Field Name Description
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screen. The detail screen displays when Add Program is selected from the 
Data menu. You can edit student service programs in both the Student 
Service Program screen and the detail screen.

Service Programs Menu Reports

Service Programs Menu Options

Service Programs Codes

Use the Service Program Definition atom to define service programs.

Report Name Description

Current Enrollment 
Report 
(PGM01)

Lists students currently enrolled in one or 
more service programs.

Cumulative Report
(PGM02)

Lists students currently or formerly enrolled in 
one or more service programs.

Student Profile
(PGM03)

Lists service programs for one or more 
students.
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Performing Year End Processes

Use the Year End Process to close all active service programs 
automatically at the end of the school year. Service programs remain 
active until the student record reflects an exit date and exit reason. The 
year end process does not affect student service program records that 
already have an exit date and exit code.

The Year End Process enters a default exit date for each active service 
program. This exit date is based on the last day of school for the term and 
track in which the student is enrolled. Term and track information must be 
defined in the Term Duration page of the School atom.

The Year End Process enters a default exit reason for each active service 
program. Service program exit reasons must be defined in the Enrollment 
page of the School atom.

The system automatically flags all service programs that were closed 
using the Year End Process. This function can be used to reactive 
students in service programs at the beginning of the next school year.

1. Open the Student Service Program atom.

2. From the Service Programs menu, select Year End Process.

3. When the system displays a message stating that all open service 
program records are closed for the year end, click OK to proceed.

Performing Beginning Year Processes

Use the Beginning of Year Process to create student service program 
records automatically at the start of a new school year. The new records 
are based on service program records that were closed using the Year 
End Process at the end of the previous school year.

The Beginning of Year Process does not create service programs for 
programs with the migration option set to 1 (No Migration) or for students 
who are no longer qualified to participate in the programs. For example:

! A former 8th grade student attends a new school for 9th grade. The 
student’s service program migration option is 2 (Migrates at Same 
School Only). The system does not re-enroll this student in the service 
program because the student no longer attends the school.

! A former 10th grade student participated in a service program with the 
migration option set to 3 (Always Migrates). This year the student is in 
11th grade but the service program has a migration limit of 10th grade. 
The system does not re-enroll this student in the service program 
because the student’s grade prohibits eligibility.
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1. Open the Student Service Program atom.

2. From the Service Programs menu, select Beginning of Year Process.

3. When the system displays a message stating that service programs 
previously closed by the end of year process will be migrated if 
possible, click OK to proceed.
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Tracking Student Activities

Use the Student Activities atom (in the Student Info Folder) to record 
current and historical data about a selected student’s student activities and 
eligibility status. The system stores this data in the Student Activities file 
(AACT). The atom has two tabs:

! Student Activities Tab
! Student Activities History Tab

The Student Activities tab displays current activity summary records. From 
this tab, you can access another screen containing additional current 
information for the selected activity.

Student Activities Information
Some fields on the Student Activities atom display information from either 
the ACT table or AARQ file.

! If you chose to create the AARQ file in the Activities Setup atom, this 
file displays.

! If you chose not to create this file (if you choose not to use the Activity 
Setup or Activity Requirements atoms), the ACT table displays.

This atom contains standard header fields for student information within 
your school. The standard header fields in this atom are read-only and 
begin with Last Name and end with Student ID.

Activities Menu Reports

Report Name Description

Summary Report by 
Student
(ACT01)

Lists activities in which students participate 
for the current school year. This report is 
sorted by student, and provides a list of all 
the activities in which each student 
participates.
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Activities Menu Options

Updating History Records

This process changes the status of current records to history records, 
where applicable.

1. Open the Student Activities atom.

2. From the Activities menu, select Update Student Activities History. The 
Update Student Activities screen displays.

3. Enter the appropriate parameters. Select one of these parameters:

! Student ID – Enter one student ID, or leave blank to process all.

Summary Report by 
Activity
(ACT02)

Lists activities in which students participate 
during the school year. This report is sorted 
by activity, and provides a list of all students 
participating in each activity.

Activity History Report
(ACT03)

Lists all current and past activities for each 
student. It may be attached to student 
transcripts.

Change of Eligibility
(ACT04)

Lists students whose eligibility status has 
changed for an activity. This report also prints 
requirement deficiencies that caused a 
student to become ineligible.

Teacher Mandate Report
(ACT05)

Reports students who are ineligible for all 
activities because of unacceptable classroom 
behavior.

Report Name Description
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! Activity – Select one activity code, or leave blank to process all.
! Grade Level – Select a range of grade levels, or leave blank to 

process all.
! Activity End Status – Select the checkbox to process completed 

activities only, or leave blank to process all activities.

4. Click Run, or click Cancel to return to the Student Activities screen 
without updating.

If you click Run, the system checks the activity records according to 
the parameters you select and moves data to the Student Activities 
History Tab as appropriate.

Determining Eligibility for Student Activities

The Comparison Update process compares and updates student data to 
determine if a student is eligible to participate in the student activities 
displayed on his or her record. The comparison takes place between data 
entered in the Activity Requirements atom and data entered in the Student 
Activities atom. The system uses the results of this process to update the 
Elig Status field with the appropriate status code and records the date of 
the process in the Elig Date field.

Before you run the Comparison Update process, you must set up and 
maintain data in the following atoms:

! Grades
! Student
! Update Course History
! Activity Setup
! Activity Requirements
! Student Activities

You must also run the following processes before you run the Comparison 
Update process.

! Calculate Cumulative GPAs for Students (Update Course History 
atom)

! Update Student Activities History (Student Activities atom)

This process provides a snapshot of data at the time the process is run. 
The system maintains this data until you run the process again. If you 
plan to run reports that depend on data from the Comparison Update 
process, run this process immediately before running the reports.
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The system performs the following functions during the Comparison 
Update process.

1. Moves the following data from current to previous status:

! Elig Status to Prev Status
! Elig Date to Prev Date
! Curr GPA to Prev GPA

2. Updates the following calculated fields:

! Curr GPA
! Age

3. These fields are updated during the Update Eligibility Process:

! Current GPA
! Prev GPA
! Age
! Curr Credits Att
! Curr Credits Failed
! Minimum Mark Failed
! Num Absences
! Num Classes
! Discipline Failed

4. These fields are updated by Update Course History and are used in 
the Update Eligibility Process:

! Cumm GPA
! Cumm Credits ATT
! Cumm Credits Earned

5. Compares all eligibility data in each student’s activity records (Student 
Activities atom) to the activity requirement data in the AARQ file 
(Activity Requirements atom) for each activity code listed for that 
student.

6. Updates the student’s Elig Status and Elig Date fields in the Student 
Activities atom, based on the results of this process.
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Comparison Update Process Screen

Comparison Update Process Fields

Field Description

Activity Activity, from the pop-up list (AARQ file). 
Leave blank to process all activities.

Student ID Student’s ID. Leave blank to process all 
students.

Calculate Age As Of 
Date

As of date (MMDDYY). The system uses this 
date to determine if the student is of the 
appropriate age to participate.

Comparison Date Range Date range (MMDDYY). Leave blank to 
process the entire school year.

Marks (Progress) Type of marks to process. Select the 
checkbox to deselect this field and have the 
system process grade marks.

Term Term duration, from the pop-up list.

Marks (Grade) Type of marks to process. Select the 
checkbox to deselect this field and have the 
system process progress marks.
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Running the Comparison Update Process

1. Open the Student Activities atom.

2. From the Activities menu, select Comparison Update Process. The 
Comparison Update Process screen displays.

3. Enter the parameters for the process.

4. Click Run, or click Cancel to return to the Student Activities atom.

Student Activities Tab

GPA Type GPA type for both the cumulative and current 
GPA.

Attendance Option All 
Day Code

Attendance type to process. Select the 
checkbox to process using all-day 
attendance.

Field Description
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Student Activities Fields

Field Description

Ln Line number in the matrix.

Act Code Code indicating the activity in which the 
student participates, from the pop-up list 
(ACT table or AARQ file).

Activity Description Description of the activity (30 characters). 
When an activity code is selected, the 
description defaults from the ACT table or 
AARQ file.

Elig Status Student’s eligibility status. Select one:

! E (Eligible), which is the default
! I (Ineligible)
! P (Probation)
! W (Waived)
! N (Not Active – Not Enrolled)
! R (Eligible with Restrictions)
! S (Eligible with Special Restrictions)

Elig Date Date the displayed eligibility status became 
effective (MMDDYY). Defaults to the value 
calculated when the Comparison/Update 
process was last performed.

Begin Date Date the student began participating in the 
activity (MMDDYY). The default is the current 
date.

End Date Date the student completed participation in 
the activity (MMDDYY).

 Sch Year School year in which the student participated 
in the activity (YYYY). The default is the 
current year.

Advsr # Advisor number of the teacher monitoring the 
activity.
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Student Activities Detail Screen

Student Activities Detail Fields

The Student Activities detail screen contains all the fields of the Student 
Activities tab, in addition to other information fields.

Data from these fields initially defaults to the Student Activities detail 
screen. Any changes made to these fields display on both screens, 
regardless of the screen on which you enter the changes.

You can display the detail screen by double-clicking any Ln field on the 
Student Activities tab. The field you select determines which record 
displays. For example, if you click COMP (Computer Club), the student 
record for that activity displays.

 Name Name of the teacher monitoring the activity 
(defaults from the Teacher atom when the 
advisor number is entered).

Activity Comment Comments regarding the student’s 
participation in the activity.

Field Description
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The following table describes the additional fields.

Field Description

Pre Status/Date Code indicating the student’s previous 
eligibility status. Select one:

! E (Eligible), which is the default
! I (Ineligible)
! P (Probation)
! W (Waived)
! N (Not Active – Not Enrolled)
! R (Eligible with Restrictions)
! S (Eligible with Special Restrictions)

Also indicates the date that the previous 
eligibility status became effective 
(MMDDYY). Defaults to the value calculated 
when the Comparison/Update process was 
last performed.

Age Student’s age at the time of eligibility. 
Defaults to the value calculated when the 
Comparison/Update process was last 
performed.

Eth Student’s ethnic code (ETH table). This 
information comes from the ASTU file for 
each student.

End Date Ending date of an activity.

Status Code indicating the student’s completion 
status at the end of the activity season. Enter 
either:

! C (Completed Activity Season)
! D (Did Not Complete Activity Season)

SeasonMo Season month (MM) for the activity (defaults 
from the Activity Requirements atom).

Yr Season year (CCYY) for the activity (defaults 
from the Activity Requirements atom).
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NumSeasons Number of seasons the student has 
participated in the activity.

Health Ex Whether the student received a health exam. 
Enter either Y (Yes) or Blank (No). The 
default is Blank.

Date Date that the student received the health 
exam (MMDDYY). This date must be after 
the health date listed in the Activity 
Requirements atom.

Drug Screen Indicates whether a student has failed a drug 
test.

Date Date that the drug screen was administered 
(MMDDYY).

EmgContact Whether the student has an emergency 
contact. Enter either Y (Yes) or Blank (for 
No). The default is Blank.

PrnConsent Whether the student has parental consent to 
participate in the activity. Enter either Y (Yes) 
or Blank (for No). The default is Blank.

StuContract Whether the student has signed a contract 
regarding participation in the activity. Enter Y 
(Yes) or Blank (No). The default is Blank.

Insurance Whether the student has health insurance. 
Enter either Y (Yes) or Blank (No). The 
default is Blank.

NumSemEnr Number of semesters that the student has 
been enrolled in this school.

EnrLastSem Whether student was enrolled in this school 
last semester. Enter either Y (Yes) or Blank 
(No). The default is Blank.

Transfer Whether the student transferred from another 
school. Enter either Y (Yes) or Blank (No). 
The default is Blank.

Field Description
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ProAth Whether the student is a professional athlete. 
Enter either Y (Yes) or Blank (No). The 
default is Blank.

Resident Whether the student resides in this school 
district. Enter either Y (Yes) or Blank (No). 
The default is Blank.

PreGPA Student’s previous Grade Point Average 
(GPA). Defaults to the value calculated when 
the Comparison/Update process was last 
performed.

CurrGPA Student’s current GPA. Defaults to the value 
calculated when the Comparison/Update 
process was last performed.

CreditAtt Number of credits the student attempted.

CreditFailed Number of credits the student failed. 

SumCredits Number of summer school credits the student 
earned.

TchMandate Code indicating a teacher mandate affecting 
eligibility. Select one of these codes:

! E (Eligible), which is the default
! I (Ineligible)
! P (Probation)
! W (Waived)
! N (Not Active – Not Enrolled)
! R (Eligible with Restrictions)
! S (Eligible with Special Restrictions)

You can enter the Ineligible code during a 
scanning process. All other codes require 
manual input.

This field overwrites the Elig Status after you 
run the Compare Update process.

Field Description
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Using the Student Activities Atom

You can use the Student Activities tab of the Student Activities atom to 
add, delete, or modify records regarding the current activities in which a 
student participates. See Data Functions. Each line in this tab represents 
one activity summary record for the selected student. Each of the selected 
student’s activity summary records contains current information on the 
specified activity.

After you add a record using the tab, you can access the detail screen. 
You can use this screen to add, delete, or modify records using the same 
process you do for the summary form. The detail screen contains all of the 
fields on the Student Activities tab, plus additional information fields. Data 
from the fields on the tab initially defaults to the detail screen. Any changes 
made to these fields display on both screens, regardless of the screen on 
which the changes were entered.

Use the selection bar on the detail screen to go to another activity record 
for the selected student without returning to the Student Activities tab.

Date Date when the teacher mandate became 
effective (MMDDYY). The default is the 
current date.

ID Identification number of the teacher 
responsible for the teacher mandate.

Code 1–9 User-defined information. You can define up 
to nine codes.

Field Description
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Student Activities History Tab

Student Activities History Fields

Field Description

Month Season month (MM) for the activity (defaults 
from the Student Activities tab).

Year Season year (YYYY) for the activity (defaults 
from the Student Activities tab).

Code Code indicating the activity in which the 
student participates (defaults from the 
Student Activities tab).

Activity Description Description of the activity (defaults from the 
Student Activities tab).

School Identification number of the student’s school 
of residence (defaults from the Student atom)

Notation Comments, if applicable.
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Modifying Records Using Student Activities History Tab

Use the Student Activities History tab to update an existing student’s 
activity record in the AACT file.

1. Open the Student Activities atom and display the Student Activities 
History tab.

2. Find the student's record you want to modify.

3. From the Data menu, select one of the following options:

! Add Activity
! Delete Activity

4. Click Save to save your changes, or click Undo to not save changes.
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Identifying Schools Previously Attended

Use the Schools Attended atom (in the Student Info folder) to maintain a 
record of schools that a student formerly attended. Make entries either 
manually or by using a function of the Update Course History atom.

Schools Attended Screen

The Schools Attended screen records which schools a student has 
attended, the school’s location, and the student’s attendance record at that 
school. You can enter or update data in the Schools Attended screen at 
any time, according to the needs of your school. See Data Menu 
Functions.

Schools Attended Screen Fields

This atom contains standard header fields for student information within 
your school.
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The standard header fields in this atom begin with Last Name and end with 
Student ID. The header fields are read-only.

Field Name Description

Ln Line number for each school row.

Sch No Number assigned to each school attended 
previously. This is a required field.

School Name Name of each school attended previously.

Begin Date Date a student enrolled at each previous 
school.

End Date Date a student left each previous school.

City City of each previous school.

State State of each previous school.

Province Canadian province for the school (if 
applicable). 

Country Country of each previous school.

Grade Student’s grade in each previous school.

Membership Membership in each previous school.

Days Absent Days the student was absent in each 
previous school.

Days Present Days the student was present in each 
previous school.
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Checking Student Distribution

The Student Distribution atom (in the Student Info folder) enables you to 
check the current student distribution or enrollment totals for the entire 
student body. This read-only atom displays distribution totals by grade 
level and gender.

The system displays data in a matrix and on a bar graph. You cannot 
modify enrollment totals from this atom. This atom provides a feature that 
enables you to export distribution data from the system for use with other 
applications.

The Student Distribution atom does not open if the system date is not 
within the attendance calendar dates.

Student Distribution Screen
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Viewing Student Distribution

When you open the Student Distribution atom, the system scans the 
student database to determine current enrollment totals. The system 
displays a message asking you to wait while this occurs.

Screen Element Description

Matrix Matrix on the student distribution screen 
displays distribution numbers and totals. For 
each grade, the matrix displays the number 
of male and female students as well as the 
total enrollment for that grade. The matrix 
also displays the number of males and 
females among the entire student body. 
Finally, the matrix displays the total current 
enrollment for the entire student body.

Bar Graph Bar graph on the Student Distribution screen 
displays a bar for the total number of males 
and the total number of females in each 
grade. The bottom axis indicates grade, and 
the side axis indicates student numbers. The 
legend indicates which color represents 
which gender.

Load From Date When you click Load from Date, the system 
displays a dialog box prompting you to enter 
a specific date for loading enrollment totals. 
Enter a date then click OK to load enrollment 
data. Alternatively, click Cancel to stop.
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Deleting Orphan Records

Use the Delete Orphan Records atom (in the Utilities folder) to delete 
orphan records of students or teachers for the current year and current 
school.

When you delete teacher records in the ATCH file (See Deleting a Teacher 
Record on page 87 of the SASIxp™ Setup and Administration Training 
Guide) or delete student records in the ASTU file (See Deleting Student 
Records on page 70.), related records remain intact in other files.

This atom enables you to delete such orphan records from the files you 
select.

Working with Delete Orphan Records Atom
You must be a Security Officer with administrative privileges to access this 
atom.

Delete Orphan Records Screen
Copyright © 2000–2004 Pearson Digital Learning Working with Delete Orphan Records Atom  233



Usage Glossary Print Back Forward First Next LastSearchContentsBookmark Previous
Delete Orphan Records Atom Options

Delete Orphan Records Atom Buttons

Selecting Files to Delete Orphan Records

1. Open the Tables Definition atom from the System Setup folder (See 
Using the Tables Definition atom on page 31 of the SASIxp™ Setup 
and Administration Training Guide.)

2. Click the Table List tab.

3. Select Utilities from the list in the Group field. The left matrix displays 
the tables named STU and TCH.

4. Select STU for students or TCH for teachers in the left matrix. The 
matrix on the right side displays the names and description of files that 
contain records related to the table you select.

5. Use the Add and Del buttons on the right matrix to add or delete file 
name(s) that are related to STU or TCH tables.

Option Description

Student Select this checkbox when you want to delete 
orphan records of students.

Teacher Select this checkbox when you want to delete 
orphan records of teachers.

Button Name Description

Run Click Run to delete the orphan records for 
the selected options.

Cancel Click Cancel to close the Delete Orphan 
Records atom.

Note: The tables - STU and TCH - are supplied with the SASIxp 
software. The Delete Orphan Records procedure will not 
function if these table names are changed.

Note: If you add files that are not related to the table selected in the 
left matrix, such files will be ignored during the Delete Orphan 
Records process.
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Deleting Orphan Records

Follow these steps to delete orphan records of students and teachers from 
the SASIxp application:

1. Close all open atoms on the SASIxp desktop.

2. Open the Delete Orphan Records atom.

3. Select the Student checkbox if you want to delete orphan records of 
students or select the Teacher checkbox if you want to delete orphan 
records of teachers. Select both the checkboxes if you want to delete 
orphan records of both students and teachers.

4. Click Run.

Viewing the Log File information

When the process of deleting orphan records completes, a message 
displays the status of the process and the location of the generated log file.

The log file contains:

! The date and time
! The name of the user who deleted the orphan records
! The file name of every deleted orphan record
! The number of deleted orphan records in every file
! The status of the process — displays as "Orphan Record Deletion 

process successfully completed" when the process is successful or 
as "Orphan Record Deletion process aborted" if the process aborts.

Note: A warning message displays if the system detects other 
atoms open on the SASIxp desktop. Click OK to close all 
other open atoms.

Note: If there are no file names related to the STU or the TCH 
tables in the Table Definition atom, an error message 
displays prompting you to enter the file name(s) in the 
Utilities group on the Table List tab of the Table Definition 
atom.

Note: When you run the process again, the new log information is 
appended to the previously created log file.
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Deleting Temporary Files

The Delete Temp Files atom (in the Utilities folder) enables you to delete 
temporary files from the datafile folder or move them to another location.

Working with Delete Temp Files atom
The temporary files in the datafile folder can be deleted or moved by a 
Security Officer with administrative privileges.

Delete Temp Files Screen
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Delete Temp Files Atom Fields

Field Description

Immediate Deletes or moves the qualified and non-
qualified temporary files immediately.

Send To Job Queue Sends the process of deleting or moving the 
qualified and non-qualified temporary files to 
the application's job queue server.

Current School Selects the qualified and non-qualified 
temporary files for the current school and 
displays the current school name and 
number in the Schools matrix.

All Schools Selects the qualified and non-qualified 
temporary files for all schools defined in the 
School atom and displays the school names 
and numbers in the Schools matrix.

Selected Schools Displays the Select Schools arrow icon, 
which enables you to select the schools for 
which you want to delete the qualified and 
non-qualified temporary files.

Select Schools Enables you to select the schools you want 
from a generic selection window. The 
selected schools are listed in the Schools 
matrix.

Note: The Select Schools option displays 
only when you choose the Selected 
Schools option.

Move Files Moves the qualified and non-qualified 
temporary files to a mapped location of your 
choice or to a default location if you do not 
specify a path.
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Deleting or Moving Temporary Files

Follow these steps to delete or move all the qualified and non-qualified 
temporary files from the datafile folder:

1. Close all open atoms on the SASIxp desktop.

2. Open the Delete Temp Files atom.

3. Choose from the following options on the atom screen:

! Immediate — To move or delete the files immediately
! Send To Job Queue — To send the deletion process to the job 

queue.

4. Select the schools you want. Choose from the following options:

! Current School — To select the temporary files for the current 
school

! All Schools — To select the temporary files for all schools defined 
in the School atom

! Selected Schools — To select multiple schools of your choice.

Select Path Enables you to specify a path where you 
want to move the qualified and non-qualified 
temporary files. The path you specify 
displays in the text box below this option. A 
default path displays in the text box if you do 
not specify a path.

Note: The Select Path option displays only 
when you select the Move Files 
checkbox.

Note: A warning message displays if the system detects other 
atoms open on the SASIxp desktop. Click OK to close all 
other open atoms. A message displays prompting you to take 
a backup of the datafiles before proceeding. Click OK.

Note: The Select Schools arrow icon displays when you choose 
the Selected Schools option. Click the icon to select the 
schools you want.

Field Description
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5. Select the Move Files checkbox if you want to move the temporary 
files from the datafile folder to another folder.

6. The Select Path arrow icon displays when you select the Move Files 
checkbox. Click the arrow icon to select the path where you want to 
move the temporary files. The path you specify displays in the text box 
below the icon.

7. Click Run.

8. On completion, a message displays the location of the log file for the 
deletion process.

Note: Delete the moved files manually from the new location if you 
no longer need them.

Note: The system selects a default path when you do not specify 
the location for moving the files.

Note: If an error occurs during the process, a message indicating 
the error displays.
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